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Introduction 

Overview 

Definition 
Acquisition, Visualisation and Data Analysis for Microsoft Windows 

Envision (enVi-z-ohn), v. 1820 [- Fr. envision, f en- En-1 + Vision  VISION ] 
1. trans.  To look in the face of; also fig. 2. To set before the mind's eye; to 

contemplate 1837. 

What is nVision? 
nVision is a data acquisition, data processing and visualisation tool designed 
specifically for scientists, researchers and engineers who are tasked with the 
acquisition, management, analysis and presentation of large amounts of technical 
data. 

High-speed data manipulation, comprehensive analysis, visualisation, and the 
rapid production of results are essential components of the overall “Visual Data 
Analysis” solution provided by nVision. 

 

nVision in action 
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What can nVision do for me? 
Once, only “supercomputers” were capable of dealing with vast amounts of data 
and of providing the extensive but expensive number-crunching capabilities 
required.  

Next came the workstations: capable, but still expensive and not user-friendly. 

Finally came the affordable PC which, because of its low cost, is now to be 
found on almost every engineer’s desk.  nVision, combined with the user-
friendly Microsoft Windows environment, makes the PC the ideal platform for 
VDA (Visual Data Analysis) work in a field, research or laboratory setting. 

 

Here are just some of the things you can do with nVision: 

• Gather data from an increasingly wide range of portable instruments, 
acquisition cards, test installations and file formats - including standard 
sound cards built into many PCs today. 

• Explore data using a wide variety of display options.  Dozens of interactive 
display methods give you all the facilities you'll need to gain insight from 
your data. 

• Interact with multiple dynamically linked views of your data, following 
trends, selecting significant events or making on-the-fly comparisons. 

• Listen to your data, using your PC sound system. 

• Gain easy access to your data, visually explore complicated data 
relationships, focus on significant points, make rapid assessments, then 
quickly create presentation-quality graphical reports from the results. 
nVision eliminates the obstacles that used to slow you down. 

• Expand the system by adding your own applications using  the 
programmer’s interface to Visual Basic or C/C++. 

• Work with object-oriented data sets using ‘drag and drop’. 

 

nVision does more than just create graphical views of your data sets - it lets you 
work interactively with them. nVision's views are dynamically linked, so you 
can see the results of changes in all views right away.  For example, if you click 
and drag the mouse to highlight data in one graph, then that data will be 
automatically zoomed in related graphs.  The same goes for cursor positioning 
and three-dimensional viewpoints.  The system works with you.   Stored 
workspaces remember how you have used the system, reducing tedious 
configuration and set-up procedures. 

nVision is a major technological breakthrough in the field of PC-based “Visual 
Data Analysis”. 
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About this Manual 
This manual describes how to install nVision and how to quickly get the system 
up and running.  For each major component it provides an introductory “tour” to 
help you quickly gain familiarity with nVision and its flexible capabilities. 

 

Overall the manual contains the following chapters: 

 

Chapter 1 describes the system requirements for nVision and provides a step-
by-step guide to installing the nVision software and the sample 
data. 

Chapter 2 gives novice users of Microsoft Windows operating systems from 
95 to XP  a brief tour around the Windows environment, quickly 
and simply showing the most important parts of the Windows 
interface.  If you are already familiar with the Windows interface 
and environment then you can skip this chapter. 

Chapter 3 provides a quick overview of the major components of the nVision 
system.  

Chapter 4 is a series of “Guided Tours” which explain the basic principles of 
the various nVision modules, grouped by the toolbar. 
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Installation 

Overview 
This chapter describes the hardware and software required for the use of 
nVision and the procedure you must follow in order to install the software 
components of the nVision system. 

Computer System Requirements 
nVision 4.35/4.40 requires the following minimum computer configuration :  

• An IBM Personal Computer, or 100 percent compatible, running 
Microsoft Windows 95/98/ME/2000/XP.  

• A better than VGA Monitor. (A resolution of at least 800x600 is 
recommended with a minumum of 256 colours, 1024x768 with 16bit 
colour would be preferable.) 

• An Intel Pentium processor running at 200MHz. (1.3GHz Pentium IV 
recommended.) 

• 256MB of system memory. (512MB of memory is recommended where 
larger data sets are to be handled.) 

• A hard disk drive with 400 megabytes of free disk space for the 
nVision system, in addition to that required for Microsoft Windows 
95/98/ME/2000/XP. 

• A high density 1.44 MB, 3.5-inch disk drive, or CD-ROM drive to load 
software. 

• A printer or other output device such as a plotter, if you want to 
produce hard copy. 

• A mouse, digitising tablet or other form of pointing device which is 
supported by Windows. 

• A Soundblaster-compatible sound card if you wish to replay or record 
audio signals within nVision. 

 

For further information on the hardware that you need to run Microsoft 
Windows 95/98/ME/2000/XP, please refer to the Microsoft Windows 
documentation. 
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Installing nVision software 

Before you start 
The nVision set-up program is a Windows application, so you will need to have 
installed Microsoft Windows 95/98/ME/2000/XP prior to the installation of 
nVision. 

NOTE: Installation of nVision is achieved through its set-up program. The 
installation cannot be performed by the manual copying of files from the 
distribution CD, since these are held in compressed form. The nVision system 
expects to be installed on your C drive. 

Performing the installation 
1 nVision can be installed from floppy discs or CD-ROM. These instructions 

assume that the software is being loaded from disc drive A:.  If you are 
loading software from CD-ROM then substitute the appropriate drive letter 
(usually D: or E:) whenever the instructions refer to ‘drive A:’.  The 
installation on the CD is broken down into floppy sized portions to allow 
you, if necessary, to install from a set of floppy disks that you create. 

  

floppy disc installation 

 

Insert the disk labelled “#1/Setup” into Drive A:. 

CD-ROM installation 

Insert the CD-ROM in the drive. This is usually drive D: or E:.  

The CD-ROM drive letter can be found by clicking on the My 
Computer Icon, and finding the CD-ROM icon. 

 

 

2 You can start the set-up program either from Windows Explorer or from the 
‘Start’ Menu.  To start from Windows Explorer, skip to section 5.  The CD 
will also auto-start a setup program if Windows is configured to auto-play 
CDs. 

To start from the ‘Start’ menu, click the ‘Start’ button and choose ‘Run...’. 
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 Running the 
 set-up program 
from the ‘Start’ menu.  
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3 When the ‘Run’ dialog box appears, type “a:\setup”, as shown below. 
 

Run Dialog box from Start 
menu. 

 
  

4 Press Enter or click on the ‘OK’ button. Now jump to step 6. 
 

Running Set-up from 
Windows Explorer 

To run the set-up program from the Windows Explorer, select the 
distribution disk drive letter, and double click on the “setup” file:  

 

 
6 The nVision initialisation dialog will appear. After several seconds the 

nVision set-up screen will appear with the set-up dialog box: 
 

nVision set-up program 

 
 

7 You can change the displayed installation directory as required. 
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nVision installation path We recommend that you make a note of the path where you are going 
to install nVision for future reference. 

 
 

8 Click on the ‘Next’ button. 

After a few more questions, the installation of nVision will begin with the status 
dialog being displayed, which shows the percentage of the installation 
completed. 
 

nVision status dialog 

 
 

When installing from floppy disks the set-up program prompts you for each disk 
in turn. Place the requested disk in drive A: and click on ‘OK’. 

When set-up has installed, it will create an nVision folder in the program menu 
similar to the one shown below. 
 

nVision Program Folder 

 
 

Finally the installation complete dialog will appear, as shown below. Click on 
‘OK’ to complete the installation. 

 

Set-up complete dialog 
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Additional information 
Once the system has been successfully installed, the nVision program folder will 
show two files that contain additional information about the current release. The 
files also appear in the ‘Start’ Menu. Simply click on the icons to open the files: 
 

Start Menu 

 
 

 

 
README.WRI contains information about new features, hardware 
and technical issues, and any other information, which post-dates the 
manual. 

 

 
Frequently Asked Questions (FAQ.WRI) contains a list of frequently 
asked questions customers have about nVision. 

  

The program folder also contains the following entries : 

 
 
The nVision server - which is used to start up nVision. 

 

 
The "key upgrade" icon - which allows the user to perform a field 
upgrade of the hardware key - see Appendix A for details. 

  
If the set-up program detects that you have Microsoft Visual BASIC 
installed on your system, you will also see the Sample Visual Basic 
Program icons - example Visual Basic programs to help you customise 
nVision. 
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Once you have installed nVision... 

If you have a hardware key 
If you have already purchased nVision and have a hardware key, then at this 
point you may wish to install the hardware key. This procedure is described in 
Appendix A. The key can be for either the printer port or a USB port. 

The hardware key is not essential to follow this tutorial, since without it the 
software will still run, albeit in demonstration mode (see below). You may 
therefore install the hardware key later on. One benefit of installing your key 
now is that you will avoid the demo dialog appearing during your tutorial 
session (see below).  

If you do not have a hardware key 
You can still follow the tutorials shown in this “Getting Started”, but you will 
not be able to print, save data, or use data other than special data sets marked as 
demo data. 

A demonstration session of nVision is also time-limited, and will stop running 
with a warning message once this time limit is reached.  

 If you have installed the full release, complete with hardware key, the system 
will function continuously without the demo message, as long as the key is left 
in place. 
 

Demonstration mode Dialog A floating 'Demo Mode' dialog informs you of the time 
remaining.  

Which section do I read next? 

Windows  Basics 
If you are not familiar with the Microsoft Windows 95/98/ME/2000/XP 
environment, you should read the chapter entitled “Windows 95/98/ME/2000/XP 
Basics”, which gives a brief overview of some of the skills needed to get you 
started. If you are happy using Microsoft Windows then you can skip this 
chapter. 

nVision Basics 
If this is your first exposure to nVision then you should read this chapter, which 
gives a brief overview of some of the elements and features of the system. If you 
are an experienced nVision user, you can proceed directly to the tour that 
interests you. 

Specific tours  
To find out more about the various parts of nVision, you can work through 
those tour sections that relate to your installed system. Remember: if you are 
working with a key attached then the system will display only those modules 
that you have purchased. To work through tours that you have not purchased, 
simply remove the key and restart nVision in demo mode! 
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Windows  Basics 

Overview 
If you are not familiar with the Microsoft Windows environment, this chapter 
shows you where to find help about using Windows. 

What is Microsoft Windows ? 
Microsoft Windows  is a Graphical Operating Environment used with IBM PC 
and compatible computers.  It has the ability to run more than one application at 
a time and transfer information between applications. 

Microsoft Windows  is what is known as a WIMP system - WIMP stands for 
Windows Icons Menus Pointers, which are the four main features of Windows.  
Once you have mastered the basic use of mouse operation all Windows 
applications work in the same way. 

If you have never used Windows before, you are strongly advised to make use of 
the tutorial guide “Ten minutes to using windows” which is found on the 
Windows  CD-ROM. 

If you have previously used Windows 3.x there is also a help section to help you 
make the transition to Microsoft Windows 95/98/ME/2000/XP. 

To read these guides click on ‘Help’ in the ‘Start’ menu. 
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Learning how to use 
Windows 
95/98/ME/2000/XP 

 
 

Features of Microsoft Windows 95/98/ME/2000/XP 

Features of a Window 
Features of a Window 

 
 

• The Control Menu is used for re-sizing, moving, maximising, minimising 
and closing windows. 

• The Title Bar shows the name of the application and is a different colour for 
the currently active application. 

• The Window Title is usually the name of the application, but can be 
combined with the name of a document or file. 
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• The Menu Bar lists the available menus from which you can carry out 
various actions. 

• The scroll bars are used to view unseen portions of the contents of the 
window. 

• The ‘Close’ button is used to end an application when you have finished 
with it. 

• To change the window’s size to fill the screen, click on the ‘Maximize’ 
button with the mouse pointer (or cursor).  After maximising, this button is 
replaced with the restore button.  Clicking on the restore button will restore 
the size of the window to its previous size. 

• The ‘Minimize’ button can be clicked to reduce the window into an icon. 

• The window border is the outside edge of the window.  Clicking and 
dragging over this area will allow you to change the size of the window. 

• The window corner can be used to change the size of two adjoining window 
borders at the same time. 

• The insertion point shows where you are in a document, and where the next 
character will appear. 

Features of the Pointer 
The mouse pointer (or cursor) is the main control device within Microsoft 
Windows. 

You move the mouse pointer around the screen using the mouse and can 
perform various operations with it such as clicking, double-clicking, dragging 
around the desktop and selecting.  These actions will have different effects 
depending on what is being pointed to at the time. 

Features of the Taskbar 
The taskbar is used in Microsoft Windows 95/98/ME/2000/XP to switch between 
different programs that are running at any one time.  Because it is a multi-
tasking environment, you can run lots of programs at once and switch between 
them using the taskbar.  

Simply click on the rectangle that corresponds to the program to which you want 
to switch.  Windows  then brings that application to the front of your desktop. 

The ‘Start’ button is always present, and this can be used to get to the program 
you want to run, to find a file, get help or shut the computer down. 

The time is displayed in the bottom right corner, along with various symbols that 
depend on your own machine’s configuration. 

 

The Taskbar 
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Features of Icons 
Icons within Microsoft Windows 95/98/ME/2000/XP are used to represent a file 
or application on the desktop or in a folder’s file list. 

 

Sample Icons 

 
 

• Double clicking an icon on the desktop or in Explorer will launch that 
specific application or file. 

• You can drag icons around the desktop. 

• You can create shortcuts to applications and files that are represented by 
icons on your desktop. 

Features of Menus 
A window’s menu bar is located immediately below the window’s title bar. 

Menus allow the user to select an item that performs a specific operation. You 
will see several standard menus, such as ‘File’, ‘Edit’ and ‘Help’ in quite a few 
applications. 

Simply click on the chosen menu option to perform it. 
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Basic Windows Techniques 

Mouse Techniques 
There are four basic Windows techniques using a mouse: 

Clicking Involves a quick press and release of a mouse button.  Mainly used 
for selecting and moving the insertion point, selecting menu options 
and using the taskbar.  The right mouse button can often be clicked to 
bring up a menu of relevant actions. 

Double Clicking Involves clicking the mouse button twice in rapid 
succession.  Mainly used for launching applications by double clicking 
the left mouse button over icons. 

Dragging Involves holding down the mouse button while moving the mouse.  
Mainly used for ‘Drag & Drop’ operations which involve picking up 
an object such as an icon, dragging it to somewhere else on the desktop 
and dropping it by letting go of the mouse button. 

Pointing Involves moving the mouse pointer on the screen until it is over the 
item of your choice. 

Window Techniques 
You can perform several operations on a window: 

Moving To move a window you need to drag the window’s title bar. 

Sizing To resize a window, point to either a corner or a border and drag it. 

Minimising To reduce a window to the taskbar, click on the window’s 
Minimise button. 

Restoring To restore a window to its previous size when it has been 
minimised, you need to click the relevant button on the taskbar. 

Maximising To maximise a window to the size of the desktop you need to 
click on the Maximise button. 

Closing To close a window (to quit an application) you need to click the 
window’s Close button. 

Accessing Menus 
To access options on a menu in Microsoft Windows 95/98/ME/2000/XP you 
need to perform the following operation: 

Point the mouse pointer at the name of the menu on the menu bar you wish to 
access. 

Click the left mouse button to open the menu. 

Move the selection cursor down until the menu item you want to select is 
highlighted and then click the left mouse button. 

To close a menu click on the menu name or anywhere outside the menu. 

Items on a menu which are ‘greyed out’ are not available for selection. 
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Sample Menu 

 

Accessing the Control Menu 
To access the control menu in Microsoft Windows 95/98/ME/2000/XP you need 
to click the left mouse button on the icon in the top left corner of the window’s 
title bar. Alternatively click the right mouse button anywhere along the 
window’s title bar. This will display the control menu from which you can drag 
the selector bar over the required option. Generally there are 6 options on the 
control menu. 

Restore - used to restore the size of the window. 

Move - used to move the window. 

Size - used to resize the window. 

Minimize - used to minimise the window. 

Maximize - used to maximise the window. 

Close - used to close the window. 

 

Control Menu 

 
 

You can select a minimised window’s control menu by pointing at the relevant 
button on the taskbar and clicking the right mouse button. 
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Dialog Boxes 
Microsoft Windows 95/98/ME/2000/XP uses “dialog boxes” to request 
information from the user.  A menu option indicates that it will result in a dialog 
box being displayed by suffixing the option name with an ellipsis (...). 

 

Sample dialog boxes 

 
 

 
 

Command Button  

  

There are six basic controls commonly found on dialog boxes : 

You click on a command button to perform an action. ‘OK’, ‘Cancel’ and 
‘Help’ are common command buttons 
   

Text Box  

  

You use a text box to enter textual data such as filenames or numbers etc. 
 
   

List Box 

 

A list box is used for selecting an item from a number of choices. 

 
   

Drop-down List  

 

The same as a list box except you first have to click on the control before 
the list becomes visible.  You can only see the selected item when the list 
is not visible. 
   

Radio Button  
  

Used for selecting one option from a group of mutually exclusive 
options. 
   

Check Box  
  

Used for selecting or deselecting an option independent of other options. 
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Windows Help 
Microsoft Windows 95/98/ME/2000/XP has its own on-line help system from 
which you can look up information about the program it is attached to.  This 
feature is generally available wherever you see a ‘Help’ command button or a 
‘Help’ option on a menu - usually the menu labelled ‘Help’. 

In most of the nVision applications that have a help file, you start up the help 
system by selecting the ‘Contents’ menu option from either the ‘Help’ menu or 
from the control menu. 

 

Help menu options 

 
 

Once you have selected a help option you will be presented with the standard 
Windows help window.  In this window, there is a row of command buttons just 
below the menu, which allow you to access the features of Windows help.  These 
buttons are described below. 

 

  Displays the Contents of the current help file. 

 Accesses the search dialog for finding a specific topic. 

  Backtracks through previously displayed help topics. 

  Prints the current help topic. 

  Views the previous related topic in the help file. 

  Views the next related topic in the help file. 

  View a glossary of terms used in Microsoft Windows 
95/98/ME/2000/XP help. 
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 nVision Basics 

Overview 
If you are not familiar with nVision, this chapter is aimed at giving you a brief 
overview of some of the systems features, and a few of the skills needed to get 
you started. 

Features of nVision 
We’ll start by running the nVision server and having a look at some of the 
system’s visible features. All the basic features remain the same from release 
4.35; the screen shots are taken from that release. 

Double click on the nVision icon (the green eye) in the nVision Program 
Folder, or select it via the Start menu. The main start-up dialog will appear, 
allowing you to select from a number of start-up options.  

 

nVision start-up dialog box 

 
The exact appearance of this dialog will depend on the system that you have 
installed, and whether or not you have run the system before, but the ‘Go!’ 
button should always be enabled. 

 

 

‘Go!’ starts nVision using a default “workspace layout”, that is, the server 
reloads the windows layout, data and server options stored in a DEFAULT file 

 

‘Previous’ starts nVision in exactly the same workspace configuration as the 
last time you used it, including applications and data objects that were loaded. 

 

‘Select...’ allows you to start nVision with a workspace configuration that you 
have previously stored. (See section on Workspaces.) 
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Appearance on start-up 
For now, just click on the ‘Go!’ button, and we’re in business. 

 

The exact screen layout will 
vary from system to system, 
but nVision should look 
something like this when you 
first start up. 

 

 

The exact layout you adopt in general usage will vary according to your personal 
taste and the capabilities of your graphics system. We generally find that it’s 
easiest to work with the toolbars and other control windows arranged on the 
edges of the desktop, leaving the central area free for data windows. 

 

This somewhat busier screen 
shows nVision configured to 
display ALL of the system 
windows and toolbars 
(except the tabbed toolbar). 

If you want to switch on 
more toolbars, access the 
‘Windows...’ menu option on 
the Server command menu. 
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Basic system windows 
Now that the system is up and running, we need to become familiar with the 
names of the basic system windows which have appeared. These are not the only 
system windows, but they’re the only ones that are essential for easy operation. 

 

The nVision server icon. Starts the nVision server, and controls loading modules. Once 
started, this icon should appear on the taskbar.  

 

A toolbar. 

 

 

 
The toolbars contain buttons to start each application program. 
Programs may be started by double clicking on the required toolbar 
entry, or by dropping data objects onto the icon.  

 

The “Trashcan”. This window may be used to dispose of unwanted data 
objects by dragging them to the trashcan and dropping 
them there. 

  

 

The “Data”  window. Data objects appear here when loaded from file or 
created by an external driver. 

 

 

 

 
 

 

These four objects (at least) should appear by default, unless of course the 
system has been otherwise permanently configured. We will meet other 
windows later.  

If none of these windows appears at this stage, refer to Appendix C, which 
describes how to set system options, and make sure that the ‘Tabbed’, 
‘Trashcan’ and ‘Data’ entries are checked in Server’s ‘Options’ / ‘Windows’ 
menu. 
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Toolbars 
 

Toolbars provide an easy 
way to execute nVision 
modules 

 

 
Toolbars offer an easy way to execute nVision modules. Each major division 
of nVision (Base 1, Base 2 and so on) has its own toolbar that contains the 
appropriate modules. Double clicking on the icon starts the module. 

 

The tabbed toolbar 

 

 

 

 

 

 

 

 

 

 

ToolTips help identify the 
program modules 

 

Alternatively, there is a ‘tabbed’ toolbar, which contains the modules for the 
entire system in one compact toolbar.  

Each division of nVision can be selected by clicking on one of the tabs: 

 
For the sake of clarity, we’ll use the tabbed toolbar for the tutorials. For a 
rundown of the contents of each separate toolbar, please refer to the “Icon 
Index” at the back of this guide. 

If you have difficulty remembering which toolbar icon is related to which 
module there are two ways to find out : 

When the mouse pointer is left over an icon, “ToolTips” help will appear to 
identify the program name. 

 
 

Pop-up help describes the 
function of each module. 

 

Holding down the left mouse button for a short time on the toolbar icon will 
display a pop-up box with a short description of the module. 

 
 

On some displays, the width of the tabbed toolbar may be wider than the screen. 
In this case, the toolbar displays an arrow as the final icon; clicking on this 
arrow scrolls the icons across to reveal the other modules that are not displayed. 

 

Scrolling the tabbed toolbar 
on a narrow display. 
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The Data Window 
Before we can view or manipulate data, it must be loaded into memory. The 
Data Window is simply a convenient place to represent the data objects that are 
currently loaded in the system, like a central storage area. It’s from here that the 
user determines where the objects are to be displayed or processed, by dragging 
the object across to a graph or a toolbox. (See the Drag and Drop description 
later.) 

When you drag data from the window into an application, the data isn’t actually 
moved; we simply create a “link” between the object and the target application. 
Some of these objects are described below 

 

The Data Window lists the 
data objects currently 
loaded. 

 

Data objects 
Entries in the Data Window are referred to as data objects. These objects may 
represent numeric data - such as a time series signal acquired from a tape 
recorder - or numeric results such as a frequency spectrum matrix. They may 
even represent system instructions, such as colour scaling, scaling ranges, zoom 
levels and so on. 

When loaded into the Data Window each object type is represented by its own 
miniature icon: 

 
Matrix  Real-valued numerical array -e.g. a run-up 

containing spectra at different RPM values. 

 
Complex Matrix A complex-valued numeric array - such as a 

complex FFT result. 

 
Film / Animation A sequence of frames or movie animation. 

 
Frame Individual frame image. 

 
Signal A time series, e.g. a stereo audio recording. 

 
Intensity Intensity measurements job / part / area. 

 
Scalar A scalar quantity - e.g. a calibration factor. 

 
Palette Colour palette, e.g. colour scale for a contour 

plot. 

 
Level Level object; used for contour scales. 

 
Viewpoint The viewpoint location, e.g. for viewing a 

waterfall. 

 
Zoom The area of data to be viewed. 

 
ASCII An ASCII text file such as a command script. 

Getting Started nVision Basics  •  24 

TLS

Is this right?



Basic nVision techniques 

Overview 
nVision is an extensive system, and to gain a thorough understanding of it all 
takes time and patience. However, with an appreciation of some basic principles 
it’s easy to make a start on the tutorial sections in this manual. These provide an 
excellent foundation, based upon which the curious user can explore and 
become familiar with the entire system. 

We recommend that you move quickly through this section to gain a little 
familiarity with the ideas, and then move onto the specific tours in Chapter 4. 
Once you have completed the tours that interest you, you can then return to this 
section with a deeper understanding.  

Executing Modules 
There are two ways you can execute modules. The first way is to execute them 
from one of the toolbars.  

Toolbars provide an easy 
way to execute nVision 
modules. 

 

 

Toolbars offer an easy way to execute nVision modules, and this method will 
be used throughout this tutorial. To execute a module from the toolbar, you 
need to click or double-click on a module entry. The number of clicks required 
depends on the status of the ‘double click to launch’ option on the ‘Options’ / 
‘Program execution...’ menu option. 

  
  

Running modules from the 
server control menu. 

 

The second method is to use the ‘Run’ option from the server control menu (use 
the right mouse button over the icon on the taskbar to access this menu). 
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Opening Files 
Opening files  

 

 

Go to the Base 1 toolbar and identify the entry that represents the FILE 
application.  
 

 
 
Run this module in order to load data. Double click on the FILE entry, and wait 
for the FILE window to appear minimised at the bottom of the screen. Click the 
restore button on this window to bring up the file dialog. 

 
 
Alternatively, select the ‘Open’ command from the ‘File’ menu of the Data 
Window. 

 

Loading files from the 
LOAD dialog. 

 

 

 
 

The files supplied fall into a number of categories, as identified by the Data 
Type list box. For now we will load a MATRIX object, which is simply a two-
dimensional matrix of numeric values. 

Identify the type of object to be loaded in the combo box entitled ‘List files of 
type’. For example, a matrix object as shown. Each data object type is identified 
by its own unique file extension - for example the matrix files have “.~ma” 
extensions.  

The available matrix data sets will appear in the window of the box. To load a 
data set, either click on the filename to highlight it, then press ‘Load’, or double 
click on the file name to perform the load immediately. 

Either method loads the data from disk, and creates a matching data object in the 
Data Window. While the data is being read from disk, the pointer will change to 
a book. 

Load more files if required, and click the ‘Done’ button when finished to close 
the dialog box. 
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Quick loading of objects 
You can reach the load dialog more directly by clicking on the ‘File’ menu entry 
located on the Data Window and selecting ‘Open…’. 

Getting information about data objects 
Data objects loaded into memory are shown in the Data Window. You can find 
out more information about objects visible in the data window by double 
clicking on the object in the Data Window. This calls up the Object Information 
dialog: 

 

The Object Information 
dialog 

 
 

In addition to showing various information for the selected object, the Object 
Information dialog also has buttons that allow you to Copy, Rename or Delete 
the object. If the object has changed since it was last saved then you can save it 
by clicking on ‘Save’.  

Saving data objects 
There are four ways to save data objects in nVision. 

1 You can drag the object from the data window and drop it over the 
minimised FILE window. 

2 You can select ‘Save’ from the ‘File’ menu in the Data Window. 

3 You can go into the Object Information dialog for the object and click on 
the ‘Save’ button. 

4 When exiting nVision you will be asked whether you want to save any data 
objects that have not been saved. 
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Removing data objects from the system 
 

The nVision Trashcan 

  
The easiest method for disposing of data is to drag the data object from the Data 
Window and drop it over the Trashcan. This will remove that data object from 
memory. 

Depending on the ‘Confirm Trashcan Deletions’ option in the ‘Data’ dialog in 
server’s options, you may be asked if you are sure that you want to delete the 
object. 

There are two other ways to remove data objects from the system: 

In the Object Information dialog for the object, click on ‘Delete...’. 

To remove multiple objects from the system: From the Data Window’s ‘Object’ 
menu, select which type you want to remove, or ‘All’ to remove all types. Then 
select ‘Kill All’ from the pop-up menu. 

Removing all the matrix 
objects from nVision. (This 
does not delete them from 
the disk.) 

 

“Clean” and “Dirty” objects 
Objects that have not yet been saved are marked as “dirty”, and if you try to 
remove them from memory, a warning will be given that your actions will 
actually destroy data.  

Once saved to disc the object is “clean” and no warning is given as it can be 
reloaded on demand. 

System options allow these warnings to be overridden, but for safety’s sake we 
advise that you leave the warnings active, at least until you are familiar with the 
operation of the system. 
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Drag and Drop 
nVision uses a “Drag and Drop” system to create links between data objects 
and program modules.  

A Drag and Drop operation consists of three steps: 

1 With the mouse pointer over the relevant object in the data window, press 
and hold down the left mouse button. 

2 With the left mouse button held down, drag the mouse pointer - which is 
now holding the data object - over to the module where you wish to use it. 

3 With the mouse pointer over the module you want to use, release the left 
mouse button. This will drop the object into the module. 

This explains the mechanical process required to “Drag and Drop”, but the 
question which remains is “What can you Drag and where can you Drop it in 
nVision?” 

You will be Dragging and Dropping data objects. As you already know once 
you have loaded an object into the system, it appears in the Data Window. From 
this point, it needs to be linked to one or more nVision modules.  

If the module into which you are placing data is already loaded, then you can 
just drag the data over that window’s client area and drop it.  

If the module is not loaded then you can drag the object from the data window 
over the toolbar icon of that module and drop it there. If the module can work 
with that type of object then it will be executed and the data object will be 
automatically linked to it. 

Working with “bays” when using drag and drop 
Some program modules work with simultaneous links to multiple data objects - 
for example GRAPH on the Base 1 toolbar can display eight different data 
objects, and so supports eight simultaneous links. Each link is represented by a 
bay, where data objects can be dropped. 

 

The GRAPH module 
showing two of its eight 
bays. 

 

 
 

If you drop an object over a module with bays but you don’t make the drop into 
a specific bay then the object will be linked to the first available (empty) bay. If 
you drop an object over a specific bay, the object will be linked to the chosen 
bay, and any existing link will be replaced.  
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Drag and Drop from Windows Explorer 
You can also load files into the system using the Windows Explorer application. 
To do this, highlight the file(s) you want to load in the Explorer Application, 
then drag them over to the nVision Data Window and drop them.  

The native nVision files in the selection will be loaded into the system, whilst 
any which are not nVision files will be ignored. For Sony EX data files a 
secondary dialogue box will appear requesting channel selection. Windows XP 
drag and drop does work but be aware that your mouse driver and other 
installation details must be up to date. 

Getting help 
The nVision system has a number of built in help files that use the Windows 
help system. Depending on the type of module you are using you will generally 
find the option to access help on either: 

A ‘Help Contents’ option on the ‘Help’ menu of the application. 

A 'Help Contents' option on the application’s control menu. 

The help files are grouped in terms of toolbars, so selecting help for GRAPH 
will take you to the help section for GRAPH in the Base 1 help file. The same 
goes for the Base 2, Tools, Drivers, DSP, Intensity and Custom toolbars. 

Some special application modules have their own user documentation; help on 
their configuration and use is only contained in this document. 

The nVision Workspace 
The nVision Workspace comprises of the layout of your windows, the active 
client modules and the loaded data objects. Storing the workspace saves time 
and effort in carrying out your analysis. For example, you may wish to have one 
screen layout suitable for data acquisition and validation, and another for 
subsequent analysis.  

To Save the Workspace Layout 
• Move the toolbars and other modules to where you would like them 

on the screen.  

• Click the right mouse button on the server’s icon on the taskbar to 
get the system menu.  

• Next, select ‘Workspace’ and ‘Save...’. The ‘Save Custom Layout’ 
dialog will appear. The name should say DEFAULT. If not, type it 
in the name field.  

• Type “User defined default” in the description and press ‘OK’. Next 
time you open nVision and click ‘Go!’, the system will start up with 
the screen layout you just saved.  

 

Of course, you can use other names and other screen layouts. You may want 
certain data objects and graphs always to appear. You can define as many of 
these layouts as you want. To recall a screen layout, other than DEFAULT, use 
‘Select’ on the ‘Start-up Options’ window. 
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Save Custom Layout dialog. 

 
At the end of a session the current workspace is automatically saved under the 
heading “Previous”, so it’s always possible to return the system to the previous 
Workspace state, i.e. as it was when you last closed down. 

You can save the current workspace under your own heading and later restore 
that state on demand, either during system start-up or even in the middle of 
another session. 

The server system menu contains a number of workspace entries: 

 ‘Workspace’ / ‘Backdrop’ removes all non-nVision windows from the 
desktop. Selecting this again redisplays them. 

 ‘Workspace’ / ‘Hide Windows’ removes all nVision windows from the 
desktop. Selecting this again will redisplay all nVision windows. 

 ‘Workspace’ / ‘Save...’ Saves the current Workspace including window 
locations, and which modules and data objects are loaded. 

 ‘Workspace’ / ‘Load...’ Loads a previously saved layout. Any data or 
modules that were loaded at the time will be loaded. 

 

Load Workspace Dialog 

 
 

Hint: Since you will almost always need to load or save data objects make sure 
that your DEFAULT workspace includes the FILE module. 

Changing the shape of the toolbars 
To enable you to create a screen layout that suits you, the shape of the toolbars 
can be changed (except the Tabbed toolbar). The ‘Format’ option from the 
toolbar’s control menu changes the toolbar shapes; each time this is selected the 
toolbar toggles to the next shape, eventually returning to the original format. 
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Changing the toolbar format.  

The Base 1 toolbar showing 
three of the possible 
configurations. 

 

Working with Regions 
The REGION Window allows you to identify a range of useful data in a matrix. 
For example, you might want to determine which area of a data set is processed 
by a particular function. 

 

Region Window 

 
As an example, you could copy a subset of a data object to a new object: 

• Plot the data using CONTOUR.  

• Use the mouse to zoom in on the area of data that you want to keep.  

• Now select the buttons with the solid rectangle in the upper and lower 
rows of the REGION Window, as in the table above.  

• Open the ‘Object Information’ dialog by double clicking on the data 
object in the Data Window.  

• Press the ‘Copy’ button.  

A new data object, consisting of the subset of data in the zoomed area is created. 
The system automatically provides a name for the new object by adding a letter 
‘C’ (for copy) to the front of the name. You can rename it if you wish. 

Hint: By using Region, it is possible to copy data from a single line in either 
axis, a single point, the area between the two cursors or the zoomed area. 
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Guided Tours 

Before you begin 

Easy introduction 
The following guide uses the various features of the system in the simplest 
possible way, but in the interests of brevity does not necessarily explain the 
why’s and wherefore’s at each stage.  Introducing nVision’s more powerful 
features here would tend to mask the basic simplicity of the system. 

Which “tour” sections do I follow? 
Since nVision is a modular system, there is no guarantee that every user will 
purchase every module, and consequently there will be sections of this guide 
that may not be relevant to you. 

If you have a hardware key attached, this will limit the modules visible on the 
toolbars to those that you have purchased.  If you are operating without a key 
then most of the modules will be available but, obviously, they will only be 
running in demo mode.  

If your system supports only Base 1 and Base 2, for example, you need only 
work through the “Basic Principles” section and then the “Base 1 Tour” and 
“Base 2 Tour”.  However, should you be interested in investigating the other 
sections, you can do so even if your key doesn’t currently support them.  You 
may be thinking of extending your system to include these modules, or you may 
simply be curious.  Just remove your hardware key and restart nVision in demo 
mode! 

Session persistence 
Sometimes during these tours, the examples that appear on your screen may not 
match exactly with the examples shown.  Don’t be too distracted by this.  The 
reason is that nVision has a long memory, and if you or someone else has been 
using the system prior to your tour, system defaults may have been changed.  
Though this feature may seem a bit of an inconvenience during your tour, you 
will find that it is a major benefit when you get down to some real work. 
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Base 1 Tour 

Overview 
This tour will use some of the simpler facilities available from within nVision, 
to give you some basic “hands-on” experience.   We’ll identify and then load 
one of the sample data sets, display its contents in a number of different ways, 
and then explore the use of zooming and cursors, and how they can assist in the 
analysis procedure. 

Some of the basic techniques are repeated here where necessary; but as we 
proceed through the various tours, this “hand-holding” will decrease. 

Identifying and loading the data 
Go to the Data Window and select the ‘Open’ command from the ‘File’ menu.  
This brings up the file dialog box, from where we can load any of the test data 
supplied with the system. 

Select “Matrix dataset” from the data type list if it is not already selected, and a 
list of available matrix files will be displayed in the scrolling list box.  

A file may be loaded by clicking on its name in the list box and then pressing the 
‘Load’ button, or by double clicking on the list box item.  If the file you want 
isn’t visible, you can move it into view using the scroll bar. 

 

File module ‘Load’ dialog - 
selecting a specific file 
corresponding to the 
selected object type, here 
we’re choosing a matrix 
object 

 
 

Select and load the file “octave1.~ma” now, using either the single click or 
double click method.  During loading, the cursor will change into an open book, 
indicating that the system is reading from disk.  (When writing data, the cursor 
changes to a fountain pen.) When this load operation is complete, also load the 
file “octave2.~ma”. 

When this file has been loaded, signified by the cursor changing back into an 
arrow, hit the ‘Done’ button on the File Load dialog box.  This closes the file 
menu, as we don’t wish to load any more data at this point.   
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We should now have two new entries called “octave1” and “octave2” present 
in the Data Window.   

Experienced Windows users might also like to know at this point that nVision 
supports full file drag and drop, not only internally but also from Windows 
Explorer, so nVision data files can be selected by dragging them from the 
Explorer window and dropping them in the Data Window.  

 

The two test data sets were 
generated using a Yamaha 
SY55 polyphonic synthesiser 
feeding a Larson Davis 
LD3200 real time spectrum 
analyser. 

 
All data in the system is represented in the Data Window, which can hold a 
maximum of 896 items.  Size the Data Window so that it occupies a reasonable 
amount of screen space, in preparation for the next stage.  If you are using a 
VGA screen for your demo it is fairly important that the windows are kept 
relatively small, whereas users of 1600x1200 graphics systems need not worry 
too much! 

Transferring data into applications 
Once data has been loaded into the data window, we need to transfer it to other 
applications in order to view and process it, but as yet we have no display 
applications running.   

 

Displaying data the Graph 
module 

  
Load the GRAPH module by double clicking on its icon in the Base 1 
toolbar.  The module should now appear with a blank frame. 

When GRAPH appears, transfer the data from the Data Window to the 
module using drag and drop (used throughout the system as the means of 
transferring data into program modules) as follows : 

1. Position the cursor over the “octave1” object in the Data 
Window. 

2. Click the left mouse button and continue to hold it down. 

3. Drag the object cursor over the GRAPH application. 

4. Release the mouse button, to ‘drop’ the object into GRAPH. 
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Module/Data object matches 
Data objects must match the 
module function for drag & 
drop to work 

There are a number of different possible data object types, and a large 
number of client modules that can display or modify that data, but not 
every client module accepts all data object types.  (In fact none of the 
applications handles all types.) When experimenting with drag and drop, 
don’t be surprised if the target module beeps, or issues a message 
rejecting the data you are attempting to drop.  The manual contains a full 
discussion of which data objects are compatible with which client 
modules. 

Displaying data in GRAPH 
Once the drag and drop operation is complete, GRAPH reacts to the drop 
operation by linking to the data object, which can be confirmed by observing the 
title bar, which should now read “GRAPH - (octave1)”.  In addition to the 
change in title, the X- and Y-axis entries are displayed, in this case Frequency 
versus Time. 

 

2D Graph 

 
 

As yet, no data is visible, (the graph area shows just a grey field with 
guidelines), so hit the ‘!Plot’ menu option to display the graph.  Most of the 
display applications have this ‘!Plot’ option, since some redraw operations are 
time consuming, and are not always required immediately.  A “switchable” plot 
allows the user to choose when redraw is required. 

Once ‘!Plot’ is selected, a representation of the data appears in the graph area.  
Frequency appears on the X-axis, and Amplitude in dB is on the Y-axis.  Also 
shown is the cursor, positioned at 6.7 seconds.  The current values for time and 
frequency are displayed at the bottom of the screen, with the corresponding 
value of the amplitude at this point. 
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The slice through “octave1” shown above is across the Frequency axis, showing 
Amplitude values at a Time of 6.7 seconds.  By clicking on the scroll bar on the 
right hand side, the slice, or cross-section, can be moved in “Time”.  If your 
graph doesn’t show the Time as 6.7s, move it now, until this value appears.  
Likewise, you can move the Frequency cursor to 200 Hz if it is not already in 
the correct position, by using the keyboard arrows. 

Experiments to try out in GRAPH 
The data displayed (Level versus Frequency) is a two-dimensional slice through 
a three-dimensional map.  Move through the other slices by using the scroll bar 
at the right of the screen.  This controls the third axis slice, which in this case is 
Time. 

Position the solid cursor by clicking in the graph area with the left mouse button, 
and observe the changing “pick-off” values as the cursor is moved.  Position the 
second (dotted) cursor by clicking in the graph area with the right mouse button. 

Zoom in to show greater detail by clicking and dragging an area within the 
graph.  Zoom out by selecting ‘Unzoom’ or ‘Undo Last Zoom’ from the ‘View’ 
menu. 

Switch the slicing direction by choosing ‘Level versus Time’ in the ‘View’ 
menu.  (The scroll bar now moves us through Frequency.) Remember to switch 
back to ‘Level versus Frequency’ before the next stage. 

Change the display method by double clicking the right mouse button on the bay 
at the right hand edge of the graph, where “octave1” is displayed.  There are 
numerous display options to be tried here under the ‘Graph Style’ group 
heading.  Note that there are eight of these bays, so we can simultaneously 
display and compare information from other data objects, or use multiple drops 
of the same object to compare slices from within the same data set. 
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Displaying the alternate slice in GRAPH 
In the previous example, using GRAPH, we accepted the default slicing 
direction (Level versus Frequency) but we may also want to see the other slice.  
Leave the existing GRAPH module, and start another copy of GRAPH by 
double clicking on the GRAPH symbol on the Base 1 toolbar.  Transfer in the 
“octave1” data set as before, select the ‘View’ menu option and choose the slice 
labelled ‘Level versus Time’.  This should give a graph something like the one 
shown below.  Note that the Frequency and Time labels have exchanged places, 
confirming that we have indeed flipped our viewpoint to the alternative slice. 

 

 
 

Hot-Linking 
The “Hot-Linking” principle is central to the design philosophy of nVision. 

If you manipulate the screen contents so that you can see both of the GRAPH 
applications, you can now move around the data, zooming in or out and moving 
the cursors, observing the interaction between the two applications.  Try moving 
the cursor viewpoint from within one of the GRAPH applications and watch the 
slice move in the other GRAPH.  We call this Hot-Linking. 

The applications co-operate like this because they have a common interest; that 
is, they are connected to the same piece of data.  As you move around the data, 
the Server keeps track of your actions, and tells other applications that are 
connected to the same data set what you are doing.  Each application is known 
as a Client, and the co-operative system as a whole is known as a Client-Server 
system. 
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Modifying data values 
The EDITOR module provides a method of manually altering data values, or 
even creating data sets from scratch, for comparison purposes.  The data set is 
loaded as before, and appears in a spreadsheet-style grid as floating point values. 

 

 
 

Cursors can be moved from within the application, and as with all other 
modules, these changes are reflected throughout the system, wherever the same 
data set is present.  Similarly, blocks may be marked using click and drag (when 
not in ‘Edit Mode’), and when numeric values are edited, the change is updated 
simultaneously in other applications. 

With “octave1” loaded, move the cursors to 1600 Hz and 4.8 seconds, where 
the value should be 79.8dB.  Go to the ‘View’ menu, and make sure that ‘Edit 
Mode’ is checked, then type in “0.0”, or some other easily recognisable value.  
When you hit <Enter> to enter the new value, the GRAPH and EDITOR 
applications update their displays to show the new value. 

Modifying data values manually is fine if there are only a couple of alterations, 
but for heavier tasks we need slightly more power.  The TOOLS modules 
provide everything we need, and are covered in a separate tour. 
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Base 2 Tour 

Overview 
Now we’re ready to have a look at some of the display modules available in the 
Base 2 toolbar.  We’ve already covered the basics of identifying data and drag-
and-drop, so all you need to know at this point is that we need to drag the 
“octave1” data set into the contour module. 

 

Base 2 - the CONTOUR 
module. 

Displaying data in CONTOUR 
Once the drag-and-drop operation is complete, CONTOUR reacts to the drop 
operation by linking to the data object, which can be confirmed by observing the 
title bar, which should now read “Contour - (octave1)”.  In addition to the 
change in title, the X and Y-axis entries are displayed, in this case Frequency 
versus Time. 

 

 

 
 

As yet no data is visible (the graph area shows just a grey field with guidelines) 
so hit the ‘!Plot’ menu option to display the graph.  Most of the display 
applications have this ‘!Plot’ option, since some redraw operations are time-
consuming, and not always required immediately.  A “switchable” plot allows 
the user to choose when redraw is required.  You can interrupt the plotting of the 
graph by clicking the mouse anywhere over the graph area. 

Once ‘!Plot’ is selected, a representation of the data appears in the graph area.  
Frequency appears on the X-axis, Time on the Y-axis, and Amplitude in dB is 
on the Z-axis, which, since we’re looking “from above” is represented by the 
colour of the data point.  This matches a contour level key (not shown here) 
which shows the assignment of colours to contour bands.  There are various 
styles of contour plot available, such as conventional contour lines, (weather 
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map style), filled interpolated plots, or as a coloured patch (which is the faster 
plotting default used here). 

Also shown are the cursors, one for each axis, positioned at 6.7 seconds in the 
Time axis, and 200 Hz in the frequency axis.  The corresponding values are 
displayed at the bottom of the screen, together with the Z value at the 
intersection. 

 

 

 
 

Try moving the cursors around in the graph area, using the arrow keys on the 
numeric keypad.  There are four peak values, as indicated by the reddest areas, 
all occurring in the 1600 Hz band, at 3.1s, 4.8s, 7.3s and 9.8s, with values of 
81.4dB, 79.8 dB, 77.7 dB and 82.3 dB respectively.  Try practising moving the 
cursors now, to see if you can locate each of these values.  You can move the 
cursors more directly by clicking with the left mouse button on the graph at the 
position you want to highlight. 

The two cursors in the example above each represent a slicing plane through the 
data set, which would yield a pair of conventional X/Y graphs.  One graph is 
Frequency versus Amplitude, and the other is Time versus Amplitude. We can 
display these slices by taking the same data set and dropping it into the GRAPH 
application, which will render the data in one of these formats. 

Identifying a region 

Click and Drag 
The main area of interest in this data set appears to be those peaks occurring in 
the 1600 Hz band, which can also be inspected more closely by zooming in 
using click and drag.  Practise this now, in the CONTOUR application, by 
clicking and holding down on the left mouse button and dragging the mouse 
right and downward (still holding the button down).  As you move, an area is 
highlighted in inverse colour, which we call a region.  When you let go of the 
mouse button, this ‘region’ will expand to fill the graph area.  It may take a few 
trials before you get the hang of this, so it’s as well to know that if you go to the 
‘View’ menu and select ‘Unzoom’, the data set will return to its original 
(zoomed-out) state. 
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Manual zoom 
The click and drag method is ideal for marking a rough region, but for exact 
positioning, a manual zoom option is also provided. In CONTOUR, click on the 
‘View’ menu item, and select ‘Manual Zoom...’ to obtain the dialog shown: 

 

 

 
 

Use the spin controls in the Frequency axis to select a lower frequency of 1250 
Hz and an upper frequency of 2000 Hz.  This range covers just the 1600 Hz 
band we’re interested in, and one band on either side. 

Now select 2.8s to 6.8s on the Time axis, which will give us the peaks that 
occurred at 3.1 seconds and 4.8 seconds. 

The Upper and lower levels in the Z-axis should remain unaltered, giving us a 
dialog that looks like the one shown above.  When we click on ‘OK’, the dialog 
disappears, and CONTOUR will zoom in to the new Region of Interest. 

 

Zoomed-in contour plot of 
“octave1”. The graph style 
has been changed to ‘Filled 
Contour’, using the ‘View’, 
‘Options..’ menu commands. 
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Synchronised Views 

Overview 
As we have seen in the previous examples, by dropping the same data object 
into different applications, multiple synchronised views of the same piece of 
data can be viewed.  Try dropping the “octave1” data object over the VIEW 
module’s icon in the Base 2 toolbar.  The module starts with the title bar 
changed to: 

“View - (octave1)”,  

Hit ‘!Plot’ on the menu bar to view a surface plot of the “octave1” data.  
Assuming that the cursor positions were left in the positions they assumed after 
the manual zoom operation, the surface should look something like the one 
below, which shows the two peaks at 3.1 seconds and 4.8 seconds. 

 

 

 
 

Each data object has its own private cursors (and many other attributes as well), 
so when the VIEW application was started and linked with the “octave1” data 
set, it showed the current region rather than the whole data set. 

Depending on the capabilities of your hardware this may be a good thing, since 
plotting a surface from a large data set can be a time-consuming task, involving 
many millions of floating point co-ordinate transformations.  This is one reason 
why a fast processor is recommended. 

The VIEW application is one where the ‘!Plot’ option is particularly useful, 
since if your graphics system is particularly slow, or the data set is particularly 
large (or both if you’re really unlucky), manipulating the view can be quite time-
consuming.  Try experimenting with the arrow and +/- keys whilst ‘!Plot’ is 
switched off, and observe the rotation of the framework, which shows how the 
data will be presented when ‘!Plot’ is turned back on. 
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The View 
module. 
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Overview of a large data set - MAP 
nVision was designed with the handling of reasonably large data sets in mind.  
This was originally for use with instruments capable of producing 16 MB of data 
in a single pass, perhaps lasting only a few seconds, and then providing the 
capability of examining subsets of that data in detail. 

In order to decide which areas of the data set are worthy of further examination, 
it’s necessary to get an overview of the data set. nVision features a number of 
methods for doing this, one of which is to view a pixel map in the MAP 
application. 

The data set is dropped into an existing MAP application or onto the MAP icon 
on the toolbar as before, and ‘!Plot’ is clicked to display the data.  In order to 
accommodate potentially large data sets, each data point is assigned a single 
pixel in the display area, the colour of which is related to the contour band of the 
associated floating point value.  This is very similar in concept to the 
CONTOUR application, but with a number of significant differences: 

• There is only one display style - one pixel for each value. 

• If the image extends beyond the current window borders, scroll bars are 
made available to bring areas of interest into view. 

• When a click and drag operation is performed, a rectangular box, which 
matches the dragged out area marks the region, but the region does not 
zoom up to fill the available display area. 

 

Map display 

 
 

The “octave1” data set isn’t particularly large (100x30), but for a data set such 
as 2000 timed samples from a 3200 line FFT spectrum analyser, it would 
provide an extremely useful tool for examining the resulting 6.4 million data 
points. 
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Tools Tour 

Overview 
Data sets are linked to the TOOLS module by dragging and dropping in the 
normal way.  The system analyses the data characteristics and builds a list of 
compatible operations or functions.  These functions are displayed in a list box, 
taking the same form as the functions that are available in command mode. 

Using TOOLS to perform arithmetic operations 
between matrices 
Execute the TOOLS module in the normal way, from the main toolbar.  The two 
data sets, “octave1” and “octave2” should still be visible in the data window; if 
not, use the FILE module to load them now. 

The TOOLS module has two bays, which are areas on the window designated as 
dropping zones for data.  They are the two rectangular areas in the top left 
corner of the window.  Take the “octave1” data set from the data window, and 
drag it into the left-hand bay.  The name should appear inside the bay, as shown 
below.  Notice that the characteristics of the data set are analysed by the TOOLS 
module, and a list of operations that suit the data is built up.  Before continuing, 
use the scroll bar to have a look through the list, which is arranged into 
categories, and examine the operations available so far.  Note that this list will 
continue to grow as the nVision system expands, and provides an increasingly 
powerful and flexible source of data manipulation. 

 

Tools MODULE: operations 
for one matrix object. 

 
 

You will probably observe that all of the operations in the list feature just the 
single data set “octave1”.  This is because so far, we have only linked this one 
data set to the TOOLS module, and the list of possible operations is based purely 
on what we can do with a single matrix. 

Now drag the matrix “octave2” into the right-hand bay.  The data set name 
appears in the right hand rectangle as before, and the list is expanded to show 
the list of operations that are possible with two data sets.  Look through the list 
using the scroll bar, and you will observe that it has been expanded to include 
calculations that use two data sets. 
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Tools MODULE: operations 
between two matrix objects. 

 
 

By clicking on one of the list items, we can select the matrix operation we want 
to perform - in this case, to subtract the contents of “octave2” from “octave1” 
on a point-by-point basis.  We can proceed to the execution phase by clicking 
the ‘Execute’ button, or double clicking directly on the entry in the list box. 

The processing will now be carried out according to the default options.  These 
options include which channels of the matrix to process, whether to create a new 
object, how much of the data to process, etc. 

This is the last stage in the procedure, and following a short delay (depending on 
the capability of your host machine) a new data set, “m1”, will appear in the 
data window.  

TOOLS operations involving scalar values 
In the previous example we saw how to obtain the difference between two 
matrix objects, but what if we simply want to apply a scalar modification to a 
matrix?  Alternatively, we may wish to extract a scalar result from a matrix by 
performing some analysis, for example, the average value. 

Creating a SCALAR object 
Scalar values exist as objects within the system, just like the matrices we have 
already observed.  They can be created in a number of ways, as we’ll see shortly, 
but for now we can create a scalar from within the TOOLS module as follows: 

• Hit the ‘Clear’ button on the right-hand bay in the TOOLS module. 

• Double click the mouse inside the rectangle that represents the bay. 

• When the ‘Set Value’ dialog appears, enter the scalar value “2” and click on 
OK. 

The system will now create a new SCALAR object having a value of two.  The 
object appears in the Data Window as before, and is also automatically loaded 
into the TOOLS module in the appropriate bay. 

Because the objects loaded into TOOLS have changed, the list of available 
operations is updated to show legal combinations of matrix and scalar 
operations. 

Performing the calculation 
To make the calculation, select the appropriate entry in the list box, and click on 
‘Execute’ as in the previous example.  For this example we choose 
multiplication. 
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Scalar multiplication 
operation. 

 

Now we can multiply each value in the matrix “octave1” simply by highlighting 
the option: 

m2 = msmul(octave1,2). 
At this point, the description “Multiply each point in octave1 by 2” will appear 
in the description panel, immediately below the list box.  The calculation is 
performed by pressing the ‘Execute...’ button. 
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Using the UNDO Module to perform What/If 
calculations 
The UNDO module is a simple program that gives the facility to restore a data 
set to its original state following the application of a calculation. 

 

The UNDO module. 

 
 

Drag the data set “octave1” into the UNDO module, which will automatically 
select the ‘Capture’ check box.  

Now we will perform a calculation on the data set “octave1” using the TOOLS 
module, for example, an increase in the data values by 50%.  To do this, first 
change the scalar value “2” to “1.5” by double clicking on the right-hand bay 
and entering the new scalar value.  Then click on ‘Responses…’ and select 
‘Ask’ in the first group of controls, which is titled, ‘Target of Operation’.  

 

Responses dialog allows 
choice of various default 
processing options. 

 
 

Now click on ‘OK’ to close the dialog. In changing this option, we have allowed 
the possibility of writing the new data over the old data in the “ocatave1” 
matrix, as opposed to creating a new matrix object.  You can experiment with 
the other options later, and observe how they give you more freedom over 
various processing parameters. 

Select the scalar multiplication entry from the operations list box and press 
‘Execute…’.  We are now able to choose our target matrix: 
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Choose the target matrix for 
the new data. 

 
 

Choose “octave1” as the target matrix for the new data, and click ‘OK’.  The 
“octave1” data points have now been increased in value by 50%. 

Now go back to the UNDO module: 

 

UNDO module: some 
commands are now enabled. 

 
 

In the example above, the multiplication was performed across the entire data 
set, which is 100 rows x 30 columns or 3000 data points in all.  The undo stack 
size is therefore set to U = 3000.  Because undo is now possible, some of the 
controls have been enabled.  

Assume that we now perform some other analysis using this data, and once the 
analysis is complete, we wish to restore the original data. 

We can undo all 3000 values by clicking on ‘All’, or undo them one by one, by 
clicking on ‘Last’.  Alternatively, the undo data can simply be thrown away 
using the ‘Dump...’ button, which effectively makes the changes permanent.  
(Although if the data is in a file, you can still get the original data back by 
throwing the modified data set in the Trashcan and reloading it). 

If you want to perform a series of staged calculations, and undo them 
individually, you can use the ‘Drop’ button, which puts a marker in the undo 
stack at the current position.  Then you can retrace to each of the markers you 
have dropped by using the ‘Retrace’ button. The “M = ?” value keeps a track on 
the number of markers available. 
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Synchronising data objects 
In the examples used in the Base 2 tour, we demonstrated the convenience of 
loading the same data set into more than one display application.  We had the 
facility to track cursor movements and zoom levels across all of the modules 
(this was called “hot-linking”).  

Given the similarity of the two data sets, “octave1” and “octave2”, it would be 
even more useful to be able to map these movements so that movements in 
“octave1” affect “octave2” as well.  The SYNCHRO module allows us to relate 
up to four data sets, and then to select if any or all of the Cursor, Viewpoint and 
Zoom operations are repeated in each data set. 

The data sets are dragged into SYNCHRO in the normal way, into one of the 
four bays. Checking the ‘Slave’ option means that the data set will follow 
movements in objects selected as master, but will not cause others to do so.  If 
‘Master’ is checked, other data sets will follow.  If both are checked, the data set 
will cause change in others as well as reacting to change. 

 

 

 

Try loading the two data sets into SYNCHRO, as shown above, and then load 
each of them into a separate CONTOUR module.  Observe how clicking in one 
CONTOUR affects the other, even though they hold different data.  Similar 
effects can be observed in display applications such as VIEW, GRAPH and 
EDITOR.  Additionally in VIEW, the angle and orientation of the data can be 
synchronised, so that two different data sets may be observed at identical 
rotations.  The VIEWPOINT option only affects data seen in the VIEW module. 

Note: you cannot specify the same data set more than once (even if you run 
more than one copy of SYNCHRO), since this would effectively setup an 
infinite loop.  
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Database Tour 

Overview 
The nVision Project Database stores information about the data objects in the 
nVision system.  The user can also create his own fields to store alongside the 
information held within an Object.  Powerful queries can be posed to the 
database to track down specific data objects.  Once you have created the records 
of the objects, you can view them in full, archive, delete or load them into the 
system. 

This tour will look at some of the features of the nVision project database.  In 
particular we will look at storing, searching for and loading records. 

Running the project database 
The use of the nVision project database is optional.  By selecting the "Use 
project database" option from the "Data" dialog box from Servers "Options" 
menu it can be permanently enabled.  Selecting this option will inform the 
database every time a data object is saved, which will allow the database to add 
or update its entry for that data object.  Alternatively you can add/update an 
entry to the database by dropping the data object directly over the database.  For 
the purpose of this tour we will enable the “Use project database” option and 
you should select that now if its not already selected. 

 

The Data dialog box to 
permanently enable the use 
of the database. 

 
 

Configuring the database 
The nVision database allows a data object to be associated with a project and 
engineer.  These associations help when entering queries to find previously 
saved data.  The System Setup dialog box is accessible form the setup menu, 
select it now.  In the project group box press the “new” button.  In the resulting 
dialog type the name of the project for this tour we will use “Test Project” type 
this now and press OK.  Enable the check box entitled “Suggest As Current 
Project”.  This will force the current project to default to “Test Project” every 
time a new record is added.  Repeat these steps for the engineer box inserting 
your name as appropriate.  The “System Setup” dialog also allows you to enter 
“User Field Names” but we will deal with these later. 

 

Getting Started Guided Tours  •  54 



The System Setup dialog 
box. Use this dialog to setup 
current projects and 
engineers and user field 
names. 

 
 

Storing Records 
A record stores information about a saved nVision data object in such a way that 
makes it possible to pose queries to isolate individual records.  These records 
can then be viewed or their associated objects loaded into the nVision system. 

A record for a data object can be entered when the data object is first saved. 
Saving the object subsequently will allow the record to be updated. 

Use the “Create Matrix” option from editor’s “Data” menu to create two 
matrices, matrix and matrix2.  Drag and drop the matrix object from the Data 
list over the file icon.  The Database will be automatically started (if it isn’t 
already running) and the “Add New Record” dialog will be displayed.  If the 
Database isn’t started automatically then ensure that the option “Use project 
database” is selected as described in the section “Running the project database”.  
The object could have been dropped directly over the database application 
instead of over file.  Both methods have the same effect. 

For now we will just accept the default information that is shown in the “Add 
New Record” dialog so press the “Add” button.  The record will now be entered 
and the object saved. 
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The “Add New Record” 
dialog 

 

Querying the Database 
The nVision database offers facilities for creating and manipulating query’s 
which can be used to select various records from the database, given a set of 
search criteria.   These facilities allow for the combination of logical operators in 
constructing queries with more than one search criteria. 

Queries are entered using the query grid on the front panel of the database.  The 
query grid is arranged with field names running across the top and search criteria 
running down the left-hand side.  Double-click in the “Show” field of Project, 
Object short and long name and Engineer so the query grid looks like that shown 
below.  Now press the “Query Results” button or select “Query Results” from 
the View menu. 

 

The “Query Results” button 
 

 

 

The Database front panel 
showing the query grid. 

 

The results of the query are now shown. The result grid will replace the query 
grid. 
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The “Results” grid showing 
all the records that match 
the criteria laid down in the 
current query. 

Loading Data Objects 
Data objects can be loaded from the results grid by selecting the record or 
records whose associated data object you want to load and pressing the “load 
objects” button or by selecting “Load Objects” from the Options menu. 

 

The “Load objects” button 
 

In the data list delete the “Matrix” object.  Now press the “Load objects” button 
to reload it. 

Creating User Fields 
The nVision project database contains 16 fields whose names can be defined by 
the user.  These fields allow the user to customise the database to suit their 
individual needs.  These field names are placed together in a group so the user 
can create multiple field names to suit his application. 

User field names are setup from the system setup dialog box.  The System Setup 
dialog box is accessible form the setup menu, select it now.  In the User Field 
Names group box press the “new” button.  This will bring up the “Create New 
User Field Names” dialog.  For the purpose of this tour we will assume that we 
are involved in tests involving tyres.  Now enter the following information: - 

Group Name  

Tyre 

Text Names 

Field 1 Make 

Field 2 Type 

Field 3 Tread Pattern 

Number Names 

Field 1 Distance Travelled 
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The “Create New User Field 
Names” dialog box is used 
for entering the names of the 
user defined fields. 

 
Press OK and select Tyre in the list of User Field Names and check “Suggest As 
Current User Field Names” the System Setup dialog should now look like that 
below. 

 

The “System Setup” dialog 
as it should now look 

 
Press “Done” on the System Setup dialog to return to the front panel. If you use 
the scroll bar to move the query grid to the right you will see the names of the 
user fields that you typed in as shown below. 
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The query grid showing the 
user defined field names. 

 

Adding Data to User Fields 
Take the “Matrix2” object created earlier and drop it over the Database 
application. The “Add New Record” dialog will appear.  Press the “User 
Fields…” button. Now enter the following information: - 

User Text Fields 

Make  AFX 

Type  Enforcer 

Tread Pattern ABZ 

User Numerical Fields 

Distance  1000 

 

The “User Defined Fields” 
dialog as it should now look. 

Press OK to return to the “Add New Record” dialog box and then press Add to 
add the record for “Matrix2”. 

Updating a record 
Whenever you save an object that already has an entry you are given the 
opportunity to update the database information for that record.  The Database 
module can act as a substitute for file and as such you can drop data onto the 
database module to be saved.  Drop the “matrix” data object over the database.  
The same dialog appears as that for entering new data apart from its name is 
changed to update record. 

We will now enter the following data in the user-defined fields. 

User Text Fields 
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Make  JP1 

Type  Magnum 

Tread Pattern QX23 

User Numerical Fields 

Distance  500 

 

Press OK to finish the user defined fields and then press Update to complete the 
record. 

 

Queries with Criteria 
The previous query we performed did not have any criteria that is to say that 
every record in the database matched.  You can filter out unwanted records by 
imposing criteria that every record must have to be included in the results. 

Scroll the query grid to the right until the distance-travelled field comes into 
view.  Double click the box at the intersection of Distance travelled and criteria.  
The criteria entry box will appear.  We want to track down all the sets of tyres 
that have done between 500 and 1000 miles. Enter the following: - 

>= 500 and <= 1000 

 

The criteria entry dialog. 

 
We need to tell the database which fields we want to be displayed as a result of 
our query.  Double clicking in the show box of the entries we want to include 
does this.  For our query we want to see the Project, Object short name and 
engineer fields so place a click in their show boxes now and then press the 
“Query results” button.  The query should match the two records we entered 
earlier. 

It is now possible to go back to the query design form and alter the query to 
filter our results.  It’s not really necessary when you only have two results but it 
will serve as a good illustration. 

 

The query design button 
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The query results grid 
showing the results of the 
query Distance >= 500 and 
<= 1000 

Press the query design button or choose “Query” from the View menu.  We will 
now narrow our search to tyres that have travelled between 500 and 1000 miles 
and have a Make beginning with J. 

Enter the following in the Criteria box of the Make field.  

J* 

The asterix indicates that all subsequent letters match, its proper name is a wild 
card.  Press OK in the Criteria entry box and then double click Makes show box 
because we want to see the Make in the result list.  The query grid should look 
as it does below. 

 

The updated query grid. 

Press the “Query Results” button. Now only the record for “Matrix” will be 
shown. 
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Animation Tour for 16bit nVision and releases prior to 
4.40 

Overview 
Animations generated by nVision’s display modules are stored in the film 
object.  The film object stores a number of still frames which form an animation 
when played in sequence.  With the nVision system there are two modules used 
for dealing with animations.  The ANIMATE module is used to view animations 
and the SPLICE module is used to edit animations. The animation tool bar was 
removed when nVision migrated to the 32 bit operating systems. 

Loading a sample animation 
First, we need to load a sample animation (film object).  To do this select ‘File’ / 
‘Open’ from the Data Window menu, or restore the FILE window. 

 

File Data Types available 
from the File Type list box, 
showing the selection of the 
film type. 

 

Select the ‘Animation sequences’ option from the data type list if it is not 
already selected, and a list of available film files will be displayed in the 
scrolling list box.  A file may be loaded by highlighting a selection with a single 
click and then pressing the ‘Load’ button, or by double clicking on the list box 
item.  If the file you want isn’t visible, you can move it into view using the scroll 
bar. 

Select and load the sample file “vector.~as”, using either of these methods.  
During loading, the cursor will change into an open book, indicating that the 
system is reading from disk, (when writing data, the cursor changes to a fountain 
pen). 

When this file has been loaded, signified by the cursor changing back into an 
arrow, hit the ‘Done’ button on the File dialog box, as we don’t want to load any 
more data objects at this point. 
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You should now see a new entry called “vector” in the Data Window. 

 

The film “vector.~as” 
shown loaded in the Data 
window. 

An animation is held as a 
series or frame objects, each 
of which holds a single 
bitmap. 

 
 

The “vector” animation was generated from a series of 3D views generated 
from an acoustic intensity test on a hi-fi loudspeaker.  Each of the frames 
represents the measured intensity for a different octave band.  As the animation 
progresses, the crossover from woofer to midrange to tweeter can be clearly 
observed.  Intensity direction is indicated by arrows pointing into or out of the 
speaker baffle. 

Displaying a sample animation in ANIMATE 
Now that we have the sample animation in the Data Window, we can display it 
using the ANIMATE module.  Drag the “vector” film icon from the Data 
Window, and drop it over the ANIMATE icon on the ‘Animate’ toolbar. 

To start an animation, select the ‘Play’ option from the ANIMATE control 
menu.  Alternatively, bring up the remote control panel by clicking on the 
‘Remote Control...’ option on the ANIMATE control menu and click on ‘Play’.  
To change the playback speed of an animation you need to bring up the play 
speed panel by clicking on the ‘Play Speed’ option on the ANIMATE control 
menu and alter the scroll bar. 

 

The Film “vector” loaded 
into the ANIMATE module, 
remote and play speed 
dialogs. 

 

Editing an animation in SPLICE 
You can edit an animation using the SPLICE module. Splice displays an 
animation in its component frames and lets you cut and paste them in any order.  
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You can also drag FRAME objects from the Data Window or another instance 
of SPLICE and drop them over a specific frame in splice to add them to the 
animation. 

 

The film “vector” loaded 
into the SPLICE module. 

 

To copy a frame in SPLICE you need to move the mouse pointer over the frame 
you want to copy and hold down the right mouse button.  This will change the 
cursor into a frame and you can then drag the copied frame to another position 
and drop it.  Depending on the Insert/Overwrite setting in the SPLICE options 
dialog SPLICE will either insert the frame at that point or overwrite the frame 
you dropped it on. 

 

The SPLICE options dialog. 

 
 

To cut frames from the animation you need to make sure the ‘Cut Frames’ 
option on the SPLICE options dialog is checked and then you can cut a frame by 
double clicking the left mouse button over it. 
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Automotive Tour 

Overview 
This tour will use some of the tools available within nVision for dealing with 
automotive data, and in particular measurements from engine run-ups.   We will 
look at waterfall data, calculating RPM values from a tacho pulse train, 
calculating order data and extracting order related effects using Kalman filtering.  

Engine Run-ups and Waterfall Displays 
We will consider how to view and analyse data from three types of engine 
measurement.  The first is the type of waterfall measurement typically performed 
by spectrum analysers that produce frequency spectra at intervals during an 
engine run-up.  

Load the matrix “runup freq” (from the ‘DEMODATA’ folder on the CD) and 
view it in the CONTOUR module. 

 

Viewing “runup freq” data 
in CONTOUR. 

 

The data in the contour window clearly shows the orders produced during the 
acceleration.  Remember that by viewing the same object in a 2D window you 
can use the “hot linked” cursors to view individual RPM or frequency slices. 

Because each measurement is plotted equally spaced, orders do not appear as 
straight lines.  By viewing the data in the PLOT module (Base 2 toolbar), the 
data is drawn spaced according to the measured RPM values so orders appear as 
straight lines.  Additional order cursors can be switched on by the menu entry 
‘View’, ‘Order Cursors…’. 

 
Tip: whenever nVision is looking for RPM values to use in a calculation, it 
expects a dictionary to be available called “Tach” in the data object.   If you 
have valid tacho data but order cursors are not present, or modules refuse to 
accept the data, check that the RPM data is called “Tach” in the object 
Information dialog.   It can be manually changed if necessary. 
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Order cursors highlighting 
orders 1 and 2 of the 
“runup freq” data. 

 

WATERFALL display, with 
viewing angle set to 90 
degrees 

 
 

Extracting an RPM profile from tacho data 
Now let us consider how to process continuous time series containing run-up 
data.  This could have come, for example, from a measurement using a sound 
card or a DAT recorder. 

 
Load the signal called “runup” (from the ‘DEMODATA’ folder on the CD).  
This contains two channels of sampled data.  One is an acceleration signal; the 
other is a pulse train with a half pulse per rev tacho signal.  In order to take an 
order cut we need to know what the RPM value is. 
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Acceleration and tacho 
pulse train signal 

  

The order analysis setup 

  

Calculate the RPM profile The order analysis module allows you to extract the RPM profile from 
the tacho pulse train.  This profile shows how the RPM value varies with 
time. Click on ‘Setup…’ to enter the hysteresis trigger parameters that 
the program uses to detect the pulse train, and remember to set the 
number of pulses per engine revolution.  In the case of the runup demo 
data, this is half (0.5) pulse per revolution. 
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The hysteresis levels let you set the threshold voltages the signal must 
cross for a pulse to be detected.  With this data the signal crosses 0 volts. 

Process the tacho channel. The RPM profile appears as a new channel in 
the runup object, which you can view in the trace display. 

 

Extracted RPM profile from 
tacho pulse train 

 

Extracting Order Information 
 

Calculating an Order Map. The order module allows you to calculate an order map. Having 
produced the RPM profile channel, select the “Accel” channel, leave the 
other parameters on their default values and click ‘Execute…’.  This will 
create a new object which contains order cuts up to the maximum order 
requested (default is 20th).  The overall order summation is also 
calculated. 

Overall level and order 
section. 

By placing the order object in two bays of the GRAPH window, you can 
overlay the overall level summation (menu option: ‘View’, ‘Sum Accel 
vs. Tach’) with individual orders (‘View’, ‘Accel vs. Tach’) to examine 
their relative contribution to the total.  The scroll bar on the right of the 
display allows scrolling through each order in turn. 

The data can be viewed as order sections against tacho RPM value (set 
‘View’, ‘Accel vs. Tach’) or as Order slices at each measured RPM (set 
‘View’, ‘Accel vs. Order’). 

Of course you can also view the data in 3D graphs such as CONTOUR to 
see all extracted orders at once, using the “hot linked” cursors to examine 
sections in the 2D GRAPH module. 
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Generating a Frequency Spectrum Waterfall 
 

 To view the frequency components of our signal we can use the DSP 
module to generate magnitude frequency spectra.  The DSP tool breaks 
the time series up into blocks of the specified FFT size, calculates the 
Fast Fourier Transform of each block and stores the result in an object 
matrix. 

Drag and drop our run-up signal in the DSP module. This module is 
located on the DSP toolbar. Select “Accel” (the acceleration data 
channel) and click ‘Process’. You will then see the ‘Assign Channels 
to Matrix Rows’ dialog. 

 

Calculating a waterfall of 
spectrums from the time 
signal 

  

Getting Started Guided Tours  •  70 



Assigning the measured 
RPM profile to the Tach 
matrix row 

Now we have an RPM profile channel available and we wish to use 
this channel to create a row of RPM values in our matrix object - so 
that each frequency spectrum will be tagged with the appropriate 
measured RPM value. 

 
“RPMProfile” should appear in the unassigned channel list. Highlight 
it and click the ‘Assign’ button.  This will assign the RPMProfile 
channel to the “Tach” matrix row. 

Display the resulting frequency data in the PLOT or WATERFALL 
modules, plotting frequency against Tach value. Note how the 
significant orders stand out. 

 

Making Tach the master 
display row 

Hint: If the plot shows a map of frequency against time and you 
require frequency against Tach, you can change to this view by double 
clicking the Data Object in the Data Window, selecting the Dictionary 
from the Object Information, and ensuring that Tach is the Master row. 

 

Kalman Filtering 
 Kalman filtering provides a form of digital tracking filter that enables orders to 

be extracted from an acquired time series signal, provided that a tacho signal is 
also measured. The tacho signal can be a pulse train, or a signal proportional to 
RPM (RPM profile).  In the case of a pulse train, the module can calculate an 
RPM profile. 

The Kalman filter module produces a number of outputs: 

• User selectable order traces 

• A “Mixer” output combining these extracted orders (including the ability 
to attenuate or amplify individual orders). 

• An RPM profile. 

• Unlike FFT based order extraction these order traces have the same 
resolution and number of samples as the original measured signal. This 
enables true addition and subtraction of component orders. The results of 
recomposition can be played back through a sound card. 
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Kalman Order Extraction 
 

 Start the KALMAN module (in the Automotive toolbar). Using the runup 
signal object, select “Accel” as the data channel and “Tach” as the Tach 
channel.  The Data channel setup allows you to select which orders you 
wish to extract.  From our examination of the runup signal earlier in this 
tour, you should have found that orders 1,2,3,4 are the dominant ones. 

Setup the tach channel processing as before with 0.5 pulses per 
revolution and click on ‘Process…’ to produce the RPM profile channel. 

Select the orders to be extracted. This is done in the ‘Filter Setup’ dialog. 
This dialog is brought up by clicking on the ‘Setup…’ button in the ‘Data 
Channel’ group.  Here you should enable the filters of the orders you 
require. Also in this dialog is a button labelled ‘Mixer…’.  Clicking this 
button will bring up the mixer dialog.  The Mixer output is the 
summation of any set of specified orders from the extracted orders.  The 
amounts of each order to be added can be varied via the sliders.  

You can overlay the mixed version on top of the original runup channel 
in the Base 1 SGRAPH module, and see just how closely the signals 
match. 

 
 

Press ‘Execute…’ to perform the filtering operation, and view the 
resulting signals in the DSP TRACE module. 
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Changing the Mixer values Now try re-running the filter but this time change the Mixer settings.  
Each of the slider bars controls the attenuation or amplification of the 
signals.  Filter 2 corresponds to order 2 in our setup so try attenuating 
this by 3 dB and calculate the result. 

 

Comparing original and 
filtered mixer outputs 

The original data and mixer output of orders 1+2+3+4 overlay nearly 
completely. 

The smaller trace is the Mixer output with order 2 attenuated 6 dB. 

If you have a sound card try listening to the difference by pressing 
‘!Play’ in the TRACE module. 
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PC Sound Card Tour 

Overview 
This tour will use the capabilities of your PC’s sound card to acquire and 
analyse data.  A standard sound card is able to measure two channels of data at 
up to 44.1kHz sampling rate, while others can manage 48kHz and above.  While 
intended for audio use, this can of course be used to measure any transducer 
capable of producing a voltage within the measurement dynamic range of the 
card.  This provides an accurate an inexpensive two-channel spectrum analyser. 

In this overview we will look at acquiring data, displaying frequency, octave and 
spectrogram functions during acquisition, and storing the results for use in other 
nVision modules. 

 This module will not work without a Soundblaster-compatible sound card. 

Data Acquisition using the Sound Card 
 

Using sound card for 
acquisition 

After connecting a signal to the microphone input of the sound card, go 
to the ‘Drivers’ toolbar and start the WAVE module.  Click on the menu 
option ‘Audio’, ‘Monitor Signal’ to measure and display the input 
signal. 

Note: if you have no signal available to measure you can read a wave 
file from disk in order to play back and explore the display capabilities.  
(Any signal object can be exported in wave format using the exchange 
module.) 

The record, play and pause buttons on the bottom of the window control 
when data is stored and when it is played: 
   

The record and playback controls Scroll to start 
⇓ 

scroll bar, moves  
⇓      through data     ⇓ 

scroll to end 
⇓

 

 
 ⇑ 

rewind 
to start 

⇑ 

Stop 

⇑ 

play 

⇑ 

fast 
forward 
to end 

 

⇑ 

Pause 

⇑ 

Record 

⇑ 

Time of 
sample 
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Monitoring in the time 
domain. 

 
 

Monitoring in the frequency 
domain. 

You can also display data in octave or third octave format during 
acquisition and playback.  The display format is selected in the ‘Audio’, 
‘Display…’ menu. 

 

The spectrogram display 
during acquisition. 

In the spectrogram display, the acquisition draws vertical stripes in grey 
scale to represent the frequency content of the data.  
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Playback through a Sound Card 
 

Playing signals through the 
sound card. 

The data in the WAVE module can be played out through the sound 
card by clicking on the play button at the bottom of the window. 

 

 

Storing measured data in 
.wav format files 

Data can be stored in WAVE (~.wav) format files which can be played 
back on any PC sound system, or even embedded in Word documents 
for reports you can listen to. (See Reports Tour.) 

To store wave files use the menu option ‘Data’, ‘Save as…’. 

Storing Signals in nVision Objects 
 

Storing data in signal 
objects for manipulation in 
nVision 

To pass acquired data to other nVision modules you need to create an 
nVision data object from the acquired data.  To do this simply select 
menu option:- 

‘Data’, ‘Create Signal…’ 

After a dialog to define which channels are required, a new signal object 
will be created in the data window, which you can then use in modules 
such as DSP. 

 

 Remember that sound playback is available for any signal displayed in 
the TRACE window - just press ‘!Play’ to playback the signal between 
cursor positions, and ‘!Stop’ to stop the playback. 
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Wavelet Analysis Tour 

Overview 
This tour will demonstrate the use of the Wavelet analysis tool to analyse the 
frequency content of short-duration time series data, comparing the results with 
Fourier analysis techniques. 

Frequency content of transient signals 
The demo data file, “door slam.~si” contains a stereo recording using 
microphones in the driver’s ear as a car door is slammed shut four times.  In the 
three seconds’ duration of the recording, some 137000 samples have been 
recorded.  This was sampled at 44.1kHz using a PC Sound Card, and imported 
from the WAVE file format using the EXCHANGE module. 

Within these short transient impact events, a wide range of frequency 
components are excited, which we would like to analyse to determine what 
causes them and how the sound quality of the closure can be improved.  Wavelet 
analysis allows us to identify frequency components during these short, transient 
events, where a conventional Fourier transform analysis would give only an 
“average” answer over the whole event. 

Load the signal data object “door slam.~si”, and view it in the TRACE module, 
located in the DSP toolbar. 

 

Door slam data in the time 
domain. 

 

Getting Started Guided Tours  •  78 



 

Using the Fourier 
Transform to view the data. 

First, let’s see what the data looks like using the Fourier transform: 

 
 

 
 

Drop the “door slam” object on the DSP module, and calculate the 
magnitude FFT of the data, using the above options.  Call the result 
“carslam_fft”, and display it in the CONTOUR module. 

 

Displaying data in log 
magnitude format. 

Display the FFT data in a CONTOUR graph.  Your display should look 
something like the one below. 
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 To make the data easier to interpret, drop “carslam_fft” into the 
TOOLS module on the Tools toolbar.  Select the operation of 
transposing the matrix, so that we can see time along the X-axis and 
frequency up the Y-axis. 

 

 
 

Drop the resultant matrix, “m1”, into CONTOUR. The X-axis should 
now be time, and the Y-axis frequency: 

 

 
 

While the FFT calculation does show the frequency content of the 
impacts, it is impossible to gain much insight into the frequency 
variation during the impact, and so we cannot identify the stages of the 
impact and their effects. This is because we can only divide the three 
seconds into 134 separate FFT calculations. If we zoom into one of the 
impacts we see that there are only ten FFT spectra within the impact, 
and the frequency information is smeared out across them so it is 
impossible to determine exact events within the impact. 
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Calculating the Wavelet Transform 
 

Calculating the wavelet 
transform. 

Drop the car slam time data into the WAVELET module. The wavelet 
calculation starts at the dotted position. The calculation is numerically 
intensive, so restrict it to the minimum number of data points. 

 

 
  

The resulting transform shows the frequency content 8192 times 
through the 0.2-second impact event. 

Distinct impacts exciting different frequencies can be seen, and the 
type of impact determined from the frequency ranges excited - and 
therefore linked to mechanical causes within the mechanism of the 
door closure and lock. 

 

Wavelet transform of a 
single door closure. 
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Intensity Tour 

Overview 
Perhaps more than 80% of the Intensity measurements made are for research and 
development.  The remainder is for source identification and location in situ, 
sound power measurements, and comparison of products’ noise output to 
standard requirements.  

The nVision Intensity system is intended primarily as a research and 
development tool, but can be used equally well as a noise-reduction analysis tool 
for in situ measurements.  Using the powerful tools available in the nVision 
Intensity system, noise sources can be quickly identified and ranked, and 
WHAT/IF analyses can be made to determine what noise reductions may be 
possible.  

Features 
• The Intensity system is designed to operate with instruments capable of 

measuring acoustic Intensity, mainly in 1/3 octaves, but just as easily in 
other fractional octaves or FFT bandwidth; however fractional octave 
synthesis from FFT is NOT provided. 

• Source ranking for quick and easy identification of highest sources. 

• WHAT/IF analysis to quickly determine what would happen if changes 
were made in the spectrum. 

• Colourful contour plotting with vectors. 

• 3D plotting. 

Limitations 
It’s just as important to outline any obvious limitations of a system, as well as 
features, so although the system is constantly being improved, these are also 
outlined here: 

• Only supports planar surfaces. 

• Cylindrical and spherical co-ordinate systems are not supported. 

• No support for data quality indicators.  Most manufacturers of Intensity 
measurement instrumentation provide these calculations inside the 
instrument. 

• No support for three-dimensional Intensity.  Three-dimensional Intensity 
measurements are made by very few people.  It can be interesting but for 
most applications provides little more information.  The technical problems 
and large errors associated with rotating the probe with respect to the three 
axes, and the very high cost and limited frequency range of three-
dimensional probes makes this type of measurement impractical. 

• Does not merge multiple spacer measurements.  This is a feature intended 
for a future release.  Most R&D measurements are made with a single 
spacer since the problem energy is contained within a limited bandwidth 
usually covered by one spacer setting. 
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Conventions 

Job, Part and Area  
nVision Intensity uses Job, Part and Area format to describe the project and its 
measured components.  This method provides a good way of summing the 
various parts of a noise source where we have a hierarchy consisting of a single 
job, with a number of parts, each consisting of a number of areas. 

In cases where the hardware supports it, the job, part and area descriptions are 
entered into the analyser during the measurement process.   If the data is being 
imported from another system that does not support job, part and area directly, 
then the import procedure will allow the information to be entered at the file 
translation stage. 

Area (physical) 
This term is also reused to describe the physical size of each measurement area. 

Vacuum cleaner project 
To demonstrate how nVision Intensity can be used, we will look at the demo 
data object “int2”, which is a test conducted on a household vacuum cleaner: 

For the purposes of this and many similar tests, an imaginary five-sided 
parallelepiped was constructed around the unit under test, which was sitting 
on a reflecting surface.  

The five surfaces were labelled “Front”, “Back”, “Left”, “Right” and “Top”, 
and these were entered into the analyser as parts.  Each of the four sides had 
ten measurement areas - two rows by five columns - and the top had 25 
measurement areas - five rows by five columns.  

Each area was labelled with its location on each surface, starting from (0, 0) 
to (1, 4) for the sides and from (0, 0) to (4, 4) on the top.  The purpose of 
this project was to determine the value of sound power, identify the highest 
frequencies and to conduct a WHAT/IF analysis to see what might happen 
to the overall sound power if the highest spectrum was altered.  

 

Imaginary Parallelepiped 
- showing the labelling 
convention used for the 
test 

 

Getting Started Guided Tours  •  84 



Step by step 

Load the data 
1 Go to the File load dialog and change the data type selection to “Intensity”.  

You should see (at least) two Intensity data sets, named “int2” and “int4”.  

2 Select and Load the “int2” data object from disk. 

NOTE:  

When “int2” is properly loaded, the Data Window will show the data in a tree 
like structure, showing the JOB, PARTS and AREAS.  Only the data object 
“int2” can be dragged into the Intensity modules, since this is a complete 
“Intensity Object”.  However, it is composed of a number of spectra stored as 
matrix objects, and these individual parts and areas can be dragged into those 
modules which support matrix objects. 

 

Intensity object displayed in 
the Data Window - the 
component parts and areas 
will only be displayed if the 
relevant options are checked 

 
 

Now drag the “int2” data object (subsequently referred to as “the data”) to the 
various Intensity modules described below: 

Project 
• Drag the data to the project module on the Intensity toolbar.  

• Observe the summary of the data, and note that you can set the frequency 
range of interest.  The default frequency range of the host instrument was 25 
Hz to 10 kHz, but we are only interested in the frequency range of 100 Hz 
to 5 kHz.  

• Press the ‘Select’ button next to the Active Frequency Bands field. 

• Now select the ‘None’ button to deselect all the filters.  

• Observe that the dark area around the filter and frequencies changes to 
white - these filters are now deselected. 

• Select all of the 1/3 octaves of interest, or filters 20 - 37, (100 Hz - 5 kHz).   
They should change to a darker colour when selected.  
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• Press OK.  At this point, you will be notified that the bands have been 
changed and asked if you want to recalculate the data set.  

• Answer YES.  The data set will now be recalculated so that the Sum and A-
wt values take account only of the bands between 100 Hz and 5 kHz.  

 

The PROJECT module. 

 
 

 
 

This module will not be needed again so you can now close it down. 
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Box 
• Drag the data into the BOX module.  This module assigns the 65 

measurements to their respective places on the parallelepiped.  Only one 
frequency is displayed at a time, with the amplitude being represented by 
the colour.  

• Change the displayed frequencies by moving the scroll bar on the right hand 
side of the window, and observe the movement through the octave bands. 

 

The BOX module. 

 
 

Box is intended to provide a visual representation of the relative amplitudes on 
at least three sides at a time.  The more areas there are the better resolution there 
will be.  

This module will not be needed again so you can close it down. 

Tree 
TREE is a very quick way to view a large group of parts or areas to see the 
contribution of the various sources at a glance.  

• Drag the data into the TREE module.  

• Select ‘View’ and look to see if the ‘Show Areas’ selection has a check 
besides it.  If it does, click on ‘Show Areas’ to deselect it.  

• Observe that you can see the percentage of contribution of all Parts at a 
glance. 

 

The TREE module. 

 
 

This module will not be needed again so you can now close it down. 
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Rank 
• Drag the data into the RANK module.  

• Observe that the left-hand scale should be scaled in Percent from 0% to 
100%.  At first, only the overall project will be shown and it will show that 
it represents 100% of the sound power. 

• Select ‘View’ and then ‘Parts’.  The five parts will be displayed in order of 
their contribution to the overall. 

• Click the cursor to the bar labelled “BACK” so that the vertical cursor is on 
“BACK”.  

• Now select ‘View’ and select ‘Areas’.   Now the graph shows the ten areas 
with the one with the highest contribution on the far left.  The highest area 
is 1_2.  

• Move the cursor to that bar. 

 

Various View modes in the 
RANK module. 
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Igraph 
• Now drag the data into the IGRAPH module.  In this module, you will see 

the spectra data as a conventional spectrum plot with the quality spectrum 
below.  The entire spectrum is not shown, but just the values between 100 
Hz and 5 kHz, as previously selected. 

• Minimise IGRAPH for the time being. 

 

The IGRAPH module. 

 

What/If 
• Drag the data into the WHAT/IF module.  In this module, you will see the 

data presented in a tabular format. 

• Observe that only the data from 100 Hz to 5 kHz are shown, as previously 
selected in the project module. 

• Observe the various parts of the display - the top line, in light green, is the 
sum of all 65 measured areas.  Just below that, in dark green, is the sound 
power of the first part - the right side.  Directly under that is the sound 
power for the ten areas, 0_0 to 1_4, of the right side.  These are summed 
upward.  By scrolling the screen upward you can see that the data of the 
remaining four sides is shown in a similar format. 

• Select ‘View’ and then click on ‘Show Areas’ to deactivate the area data.  
You will now see that only the Part and Project power levels are shown.  

 

The WHAT/IF module 

 
• Now reselect ‘Show Areas’ from the ‘View’ menu. 

NOTE: If the data shown are Intensity but the text describes power, then the 
system may have been reconfigured.  To display power, select the ‘View’ 
menu and then select ‘Channel’.  Select power in the displayed combo box. 

• Minimise WHAT/IF for the time being. 
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Face 
The FACE module is not appropriate for displaying this particular data. There 
are too few measurement areas to give a meaningful display.  The FACE graph 
is similar to BOX except it only displays one face or surface at a time; however, 
the FACE module provides smoothing and line-contour plotting whereas BOX 
does not.  

Multimap 
 

 

 
 

Putting it all together 
As with the standard modules, it’s possible to observe the data in more than one 
Intensity module simultaneously, and because of this powerful feature, you can 
quickly locate and modify the problem frequencies or sources.  The system links 
activities in the various modules so that cursor movements, zooms, etc., which 
occur in one module are reflected in other modules that are linked with the same 
data. 

 

• Move the three module windows, WHAT/IF, IGRAPH and RANK, so that 
they do not overlap each other.  This is so that we can observe the data in 
each, without the need to manipulate the windows themselves. 

• Move to RANK and select ‘Parts’ from the ‘View’ menu.  

• Move the vertical cursor on to the highest Part, which should be Back.  

• Select ‘Areas’ from the ‘View’ menu, and again move the vertical cursor to 
the highest area, which should be 1_2.  This now represents the area with 
the highest power level.  The highest spectrum will be displayed in 
IGRAPH.  

• In the IGRAPH module, move the vertical cursor to the highest peak, 315 
Hz.  You will see that the WHAT/IF module will highlight the intersection 
of the 315 Hz and the 1_2 area.  In this example, this is the highest peak in 
the entire project.  At this point we can edit this single peak and recalculate 
the entire data set. 
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• In the WHAT/IF module, select ‘View’ and ‘Modify Marked Block’.  A 
small menu will open from which you will indicate the change to be made.  

• Click on the highlighted rectangle, 72.0 in the 315 Hz column.  This 
activates the ‘Apply’ key in the ‘Modify Marked Block’ dialog.  The default 
is to apply a 10-dB reduction to the highlighted cell. 

• Press ‘Apply’.  The data set will be recalculated and the various modules 
will be updated. Notice the reduction in the 315 Hz band in IGRAPH and 
the change in the ranking of 1_2 in RANK. It is now the fifth highest.  

• Change RANK to show the Parts’ ranking.  The Back is now the fourth 
highest.  These changes in the WHAT/IF module can be applied to a single 
frequency at a single point or any series of frequencies or areas. 
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Loudspeaker project 
The purpose of this project was to make a contour map of the front face of a 
loudspeaker, consisting of one bass woofer, one midrange driver and one 
tweeter.  The idea was to observe the crossover frequencies and to see how 
Intensity modules are capable of mapping the locations of the major drive 
components.  

A grid was laid out over the surface of the speaker consisting of 77 points, in 11 
rows by 7 columns, and the Job was labelled as “int4”.  There was a single Part 
labelled ‘Front’, and the 77 points or areas were labelled with the co-ordinate 
location of the measurement point, running from 0_0 to 10_6.  

The stationary point method was used to take the data, which can be briefly 
explored as follows: 
 

• If you followed the previous example, drag the “int2” Intensity object into 
the trash can, (in order to conserve system memory) and load the “int4” 
object.  

• Drag “int4” into the FACE module so that we can see the contour map.  
Depending on the smoothing mode selected you will see either a contour 
map that looks like a series of blocks or one which appears as a smooth 
map.  Block mode provides the fastest plotting.  

• This module displays the contour map at a single selectable frequency.  

• Move the slider bar to the right of the graph until 500 Hz is shown. You will 
see that this is the crossover point between the woofer and midrange.  At 
this time, you might want to change the smoothing to filled contour or line 
to improve the look of the display. 

• To see a 3D graph, select the ‘Data’ menu and then the ‘Create Matrix…’ 
option. Accept the matrix default name of “int4”.  You will see that a new 
matrix has been created in the Data Window.  

• Move the newly created “int4” Matrix to the VIEW module on the Base 2 
Toolbar.  

• Select ‘!Plot’ and you will see a 3D map of the 500 Hz contour map. 
 

Speaker and Speaker with 
Intensity Contour Map (at 
500 Hz).  

 

 

Things to try 
Combine what you have learned in the Animate and Intensity tours by 
automatically creating a movie of the loudspeaker response in the FACE module 
and showing the result in the Animate module.  This will show a 3D map of the 
loudspeaker baffle for every third octave band. 
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DSP Tour 

Overview 
This tour will use some of the simpler facilities available from the nVision DSP 
Toolbar to give you some “hands-on experience”.  The tour will start by creating 
a sine wave, which is buried in white noise.  The main objective of the tour from 
that point on will be to recover the sine wave from the noise by application of a 
suitably designed filter.  This process will involve the use of most of the basic 
modules provided by the DSP Toolbar. 

Features 
The DSP toolbar consists of a suite of modules designed to perform signal 
processing on time-domain signals.  The main functions include: 

Display and Playback of signal traces 

FFT Toolbox  (functions include Power Spectral Density, cross spectrum, 
coherence, correlation and transfer functions). 

Wavelet analysis 

Fractional Octave analysis 

FIR Filter Design. 

Waveform generation 

Generating a Test Signal 
Execute the WAVEFORM module by double clicking on its icon in the DSP 
toolbar.  The following window should appear. 

 

 
 

Click on the ‘Signal...’ button to invoke the following dialog: 

 

 

 

The dialog will show the name of the signal object that WAVEFORM intends to 
create; it will be of the form “waveX” where X is a unique number.  If no other 
signal objects are currently loaded into nVision, the name of the signal to be 
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created should be “wave0”.  For this tour, we only require a single channel of 
data so we may accept the default settings by clicking on the ‘OK’ button. 

Now we must define the parameters of the signal to be created.  To do this click 
on the ‘Parameters...’ button.  The following dialog will be displayed: 

 

 

 

From this dialog, we wish to define a 200 Hz sine wave corrupted by uniform 
white noise with a S/N of -10 dB. Click on the ‘Frequency’ edit box and enter a 
value of 200.  Next click on the ‘Uniform’ radio button to enable the noise 
generator and specify a value of -10 in the ‘Signal/Noise Ratio (dB)’ edit box.  
The remaining options may be left with their default values.  Click on the ‘OK’ 
button when you have completed the changes. 

We are now ready to create the test signal, which is done simply by clicking on 
the ‘Create’ button.  The new signal object should be visible in the nVision data 
window with the name “wave0”. 

Viewing the test signal 
Load the TRACE module by double clicking on its icon in the DSP toolbar.  The 
module should appear with a blank frame. 

When TRACE appears, transfer the signal “wave0” from the Data Window to 
the module using drag and drop (described in the “nVision Basics” section). 
TRACE should react by changing its title bar to read “Trace - (wave0)” and 
automatically plotting the signal data.  The trace module shows a representation 
of the time data, where time appears on the X-axis and signal level on the Y-
axis.  For the noise corrupted sine wave, we should obtain a display similar to 
the one below. 
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Trace includes a pair of cursors, one solid and one dotted, which may be used to 
take readings from the channel.  At the top right of the display are four values: 
X1, Y1, X2 and Y2.  X1 and Y1 represent the position of the solid cursor, while 
X2 and Y2 represented a dotted cursor.  When a signal is first created the 
cursors are set to the first data point in the channel (i.e. X1 = X2 = 0).  To 
change the position of the solid cursor, simply move the mouse pointer over the 
point of interest in the signal and click the left mouse button.  You can then use 
the arrows keys on the numeric pad to move to the exact location.  A similar 
approach is used to change the position of the dotted cursors but this time the 
right mouse button must be used to select the approximate position before the 
arrow keys may be used.  

Identifying a region 
Trace will allow you to zoom in on a region of interest in the data set by using 
click and drag.  Practise this now by first selecting ‘Unzoom’ from the ‘View’ 
menu.  The signal should have a duration of 0.4096s.  Zoom in on an area of the 
signal around 0.2s by clicking and holding down the left mouse button and 
drawing the mouse right and downward (still holding the button down).  As you 
move, an area is highlighted in inverse colour.  When you let go of the mouse 
button, the highlighted region should be expanded to fill the trace display. 

Signal Playback 
If you have a PC equipped with a suitable sound card, TRACE will have enabled 
the ‘!Play’ button on its menu.  Playback will commence from the earliest cursor 
position and end on the latest one.  If you have a sound card, practise this now: 
first, unzoom the signal and set the cursors at the signal’s start and end positions. 
Then simply hit ‘!Play’ to hear the noisy sine wave. 

Creating a Power Spectrum of the Test Signal 
Load the DSP module by double clicking on its icon on the DSP toolbar.  The 
following window should appear: 
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When DSP appears, transfer the signal “wave0” from the Data Window to the 
module using drag and drop (described in the “nVision Basics” section). DSP 
should react by changing its title bar to read “DSP - (wave0)” and enabling 
many of the DSP options.  In this tour we want to generate the power spectrum 
of our test signal so that we can later compare it with the signal that has had the 
noise suppressed.  To obtain the Power Spectrum of the test signal, perform the 
following steps: 

 

• Click on the ‘Single’ radio button in the ‘Mode’ group. 

• Select ‘Power Spectrum (PSD)’ from the ‘Process Mode’ list box. 

• Select ‘Blackman’ from the ‘Window’ list box. 

• Select ‘4096’ from the ‘FFT Size’ list box. 

• Select the ‘Log’ radio button in the ‘Scaling’ group. Also, enter a value 
of 1.0 in the ‘dB Reference’ edit box if it is not already set to this value. 

• Click on the ‘All’ button in the ‘Primary’ channel group to select the 
channels to process. The ‘Process...’ button should now be enabled. 
 

Once DSP is configured, click on the ‘Process...’ button to start the analysis.  
You will first be presented with a dialog prompting you for a matrix name.  
Enter the name “noisypsd” in the edit box and click on ‘OK’. 

Depending upon the settings in DSP’s ‘Options’ dialog, you may be presented 
with a dialog with a title “Assign Channels to Matrix Rows”.  If this dialog 
appears, simply respond by clicking on ‘OK’. 

Viewing the Power Spectrum  
Once DSP has completed its calculations, a new matrix object called “noisypsd” 
should appear in the Data Window.  To view this data set, launch the GRAPH 
module from the Base 1 Toolbar, then drag and drop the “noisypsd” object into 
the module.  More detailed instructions on using GRAPH are available in the 
“Base 1 Tour”.  Try zooming in on the data set from 0 to 2000 Hz.  Using the 
cursors you should be able to determine that the peak level of the 200 Hz sine 
wave is -4.0 dB, and from visual inspection it is clear that the noise level is 
around -20 dB. 
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Designing a Bandpass Filter 
The signal to noise ratio of the test signal can be improved drastically by passing 
the test signal through a bandpass filter, which has been designed to pass the 200 
Hz sine wave unmodified, but to suppress all other components.  In this part of 
the tour, we will design one such bandpass filter using the DSP filter design 
module. 

Load the FILTDES module by clicking on its icon in the DSP toolbar. The 
module should appear as shown below. 

 

 
 

First, click on the ‘Options...’ button to invoke the following dialog. These 
options allow the user to select which of the Magnitude, Step and Phase 
responses are generated automatically whenever any filter is created.  For this 
tour, we are only interested in the Log Magnitude Response.  Therefore, ensure 
that only the Magnitude Response check box is checked and that the Log radio 
button is selected.  Click on the ‘OK’ button to return to the main panel. 
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From the main FILTDES panel, select ‘Bandpass’ from the ‘Filter Type’ list box 
and click on the ‘Windows’ radio button in the ‘Design Method’ group box.  We 
are now ready to design the bandpass filter, so click on the ‘Design...’ button to 
bring up the dialog for bandpass filter design. 

 

 
 

We require a filter that will allow our 200 Hz sine wave to pass unchanged, but 
will suppress as much of the noise as possible.  Unfortunately, there is not 
enough time within this tour to explain the mathematics used in the design of 
such filters; this is discussed in many good DSP text books.  For the purposes of 
this tour, we will design a filter with a pass band from 190 Hz to 210 Hz and 
stop band frequencies of 180 Hz and 220 Hz.  Enter the following values: 

 

• Select ‘Kaiser’ from the ‘Window’ group. 

• Enter “190” into the ‘Lower Passband’ edit box. 

• Enter “210” into the ‘Upper Passband’ edit box. 

• Enter “180” into the ‘Lower Stopband’ edit box. 

• Enter “220” into the ‘Upper Stopband’ edit box. 

• Finally, the ‘Estimated Taps’ edit box should be displaying a value of 
3625.  This is the minimum number of taps necessary to realise a filter 
with the specified parameters.  Use this value by entering it into the 
‘Desired No of Taps’ edit box. 

 

Now that the filter design parameters have been set, click on the ‘OK’ button to 
initiate the design.  FILTDES will create two new matrix objects, which should 
appear in the Data Window.  The data set “fband0” contains the filter 
coefficients while “mag0” contains the log magnitude response of the filter. 

The magnitude response may be viewed by dragging and dropping “mag0” into 
the GRAPH module.  By zooming in around 200 Hz, you should see a response 
similar to the one shown below. 
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Applying a Filter to the Signal 
The next stage in this tour is to take the filter we have just designed and apply it 
to the noisy 200 Hz sine wave in order to improve its signal to noise ratio.  The 
DSP Toolbar includes a Finite Impulse Response (FIR) filter module called 
FIRFILT, which performs this operation.  Execute the FIRFILT module from 
the DSP Toolbar in the normal way.  The module has two bays, which are areas 
on the window designated as dropping zones.  The left-hand bay accepts the 
signal object that is to be filtered, while the right-hand bay accepts the matrix 
object that contains the filter coefficients.  Take the “wave0” data set from the 
Data Window and drag it into the left-hand bay.  The name of the data set should 
appear in the bay, as shown below. Next, take the “fband0” data set and drag it 
into the right-hand bay. Select the channel “Ch 1” by pressing the ‘All’ button in 
the ‘Channels’ group.  The ‘Apply’ button should now become enabled, 
indicating that the module is ready to apply the filter. 

 

 
 

Before the filter is applied, we may need to change some of the FIRFILT 
options. Click on the ‘Options...’ button to bring up the following dialog: 
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Change the settings on the options dialog so that they match the one shown 
above.  ‘Filter Delay’ should be ‘Automatic’, ‘Method’ should be ‘Fast’ and the 
‘Put data into new object’ check box should be checked.  Once these options are 
set click on ‘OK’. 

From the FIRFILT main window, click on the ‘Apply…’ button. A dialog will 
appear prompting for a matrix name for the filtered signal.  Enter the name, 
“cleansig” into the edit box and click on ‘OK’.  The FIRFILT module will 
proceed to filter “wave0” and the result should appear in the Data Window as a 
new signal object called “cleansig”. 

Viewing the filtered result 
Take the data set “cleansig” and drag and drop it into trace. You should see a 
result similar to the one shown below.  The 200 Hz sine wave is now clearly 
visible above the noise. 

 

 

Comparing Power Spectra 
Generate a power spectrum for the filtered signal “cleansig” using the same 
procedure described in the above section “Creating a Power Spectrum of the 
Test Signal”.  The only difference will be in the name of the generated spectrum; 
use the name “cleanpsd” for the new data. 

By dragging and dropping both “cleanpsd” and “noisypsd” into a copy of 
GRAPH, we can directly compare the results of the filtering process. Again, 
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zoom in around 200 Hz to produce a graph similar to the one shown below.  It 
should be clear from these plots that the noise level has been reduced by over 60 
dB outside the pass band of our bandpass filter, while the 200 Hz sine wave 
remains unchanged in level. 

 

Things to try 
Try producing a two-channel signal object in which each channel contains a sine 
wave of the same frequency, but where both are corrupted by different types of 
noise (first channel uses Uniform while second channel used Gaussian).  Ensure 
that you specify a signal/noise ratio which buries the sine wave (-10 dB should 
be sufficient).  Using the DSP Toolbox coherence operation between these two 
channels, you should be able to identify that the only coherent component is the 
sine wave. 
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Import Tour 

Overview 
In this tour, you are introduced to the range of data import options available 
within nVision.  nVision includes a wide range of device and file drivers, 
dynamic data exchange links with Microsoft Excel and a flexible exchange 
module that allows import and export of data to user-defined formats. 

Help on Importing Files 
Even with the minimum nVision system, you can access the EXCHANGE 
module, from which you can import data.  You can find out more information 
about this module by accessing its on-line help.  To do this you need to select 
the ‘Contents’ option from the ‘Help’ menu.  Also, see the “Exchange” Tour, 
which follows this section. 

If you have the Drivers toolbar enabled in your nVision system, you can find out 
more information about importing data by accessing the Drivers help from the 
Drivers toolbar’s control menu.  Selecting the ‘Help Contents’ option will 
display the nVision Drivers’ help file. 

You can also access help for a specific driver module by selecting the ‘Contents’ 
option from the ‘Help’ menu of the specific module.  If it does not have a help 
menu then select the ‘Help Contents’ option on the module’s control menu. 

File Import - Universal Files 
The File Import menu supports Specific file formats, exclusive from the 
EXCHANGE module.  One example is the SDRC Universal file format. 
 

 An example universal file is “crash3.uff”. 
   

File Import menu 

 

  Select the file format. 

 

Chose the appropriate file 
delimiters 

Choose the appropriate import filter options, by clicking on the 
‘Options’ button. 

Universal files are ASCII (text) files.   However, each line of the file 
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may have a record delimiter at the end of it.   Whether this is present 
will depend upon the operating system of the computer used to create 
the file, and the transfer method used to move it to your PC.   A UNIX 
based system, for example, is likely to include CR/LF (carriage 
return/line feed) characters at the end of each line. 

Tip: if the file read fails to find any records in the file, try the other 
option.   Once you have identified the correct setting, click on Save in 
the options menu to set this as the default value. 

 

 
   

Read the file by clicking on the ‘Open’ button, and entering the 
filename. 

The data will appear in the Data Window.   In the case of the car crash 
data, this is a time series.   It would make a good data source to try 
Wavelet analysis. 
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Exchange 

Introduction 
The EXCHANGE module is capable of importing and exporting data in a 
variety of file formats, and is also capable of learning new formats, through the 
‘intelligent’ macro facility. 

Binary file import 
Binary files are much simpler to import than ASCII files, but they also require 
the user to understand exactly how the source file is laid out in order to import 
data correctly.  Unlike an ASCII file, binary files are not self-describing, and it’s 
not possible to have a peek into them to get some clue as to their layout.  
Consequently, the importing and exporting of binary data is covered in depth in 
the manual. 

ASCII file import 
The following procedure describes the steps necessary to import an ASCII file, 
that is, a normal readable text file. 

We will import a file called “log4.txt”, which as we shall see, contains two 
channels of data. 

Start the EXCHANGE module from the Base 1 toolbar.  The first step is to 
choose the ‘ASCII’ option from the ‘Import’ menu, at which point we will be 
presented with the dialog shown below: 
 

 

Highlight the file “log4.txt”, and click on the ‘Open’ button. 
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We are going to perform a wizard import, where each step of the process is 
under the control of the user.  The program automatically monitors the steps we 
take during the import procedure, and later we’ll get the chance to save those 
steps as a macro, which can then be used to import a similar file automatically. 

Select the ‘Wizard’ option and click on ‘OK’. 
 

 
 

The program reads the “log4.txt” file and automatically analyses it, so that it 
can offer the user a reasonable idea of what the file contains.  Due to the varied 
nature of ASCII files, this can be a difficult job, but the program knows about 
the more common methods.  The file shown here has two channels (columns) of 
time stamped data, separated by tabs, with lines separated by linefeed characters. 
 

 
 

The analysis offered automatically by the program can be accepted at this point, 
or if the display doesn’t look right the user can specify alternative line and 
column separators, and then try these out using the ‘Reformat’ button. 

When the data layout displayed in the client area of the program is acceptable, 
click on ‘OK’ to accept the formatting and the program will perform the first 
regular trial.  Our file should now look something like the display shown below.  
The program has organised the data into regular rows and columns, and we can 
now clearly see the Time stamps, and the two channels of data, A1:1 Temp1 and 
A1:2 Temp2. 
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The data as displayed is obviously more readable than the original, but in order 
to create a data object we need to take further steps to refine the layout.  From 
the first trial format above it’s clear that the numeric data is mixed up with 
information that describes the data. 

In common with the EDITOR module the EXCHANGE module regards central 
white grid portion of the display as data, and the surrounding grey buttons as the 
parts which display information about the rows and columns of the grid. 

Using this principle as a guide, we can move the top line of the display so that it 
occupies the column description area.  This is achieved very simply, using the 
import wizard dialog. 

 

 
 

The top row of the display should already be highlighted, but if it isn’t, click on 
the ‘1’ button on the left-hand side of the row.  Now click on the ‘Copy Row To 
Title’ button on the wizard dialog.  This copies the text from the selected row 
onto the grey buttons above, but leaves the original text intact.  Although this 
step is not necessary for importing data, you will find that copying the 
appropriate row and column titles onto the buttons will help when you are 
moving around in larger data sets. 

 

Getting Started Guided Tours  •  107 



 
 

Having moved the first row upwards into the column title area, we can also 
move the first column containing the time, so that it appears as the row title.  
Highlight the column by clicking on the grey area marked ‘TI1 Timer’ at the top 
of the first column. 
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Click on the ‘Copy Column To Title’ button to use the highlighted column as the 
row title. The display should now appear something like that shown below.  

 

 

 

The display is now in a readable form, with the data positioned in the grid, and 
row and column titles correctly established.  We’re now ready to proceed to the 
next stage, where a data object is created. 

Now we need to mark out the numerical data values that apply to one channel.  
In this case, we start a click and drag operation at the “23.21” value immediately 
below “A1:1 Temp1”.  Drag vertically downward to the last value (also “23.21”) 
which is on the row labelled “92.671”. 
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On the import wizard dialog box, click the ‘Add To Matrix...’ button. 

 

 

 

Click on ‘OK’ to perform the operation and return to the table of values. 

We have now added one channel of data and can continue by adding the second. 
Click on the “22.07” value immediately below “‘A1:2 Temp2”, but this time do 
not drag out the values for this channel.  By adding the first channel, we 
effectively told the program how many rows and columns each channel 
occupies.  Now we can let it do the work for us by selecting the first value for a 
channel and clicking on the ‘Mark Channel’ button. 
 

 
 

Select ‘Add To Matrix...’ and click on OK. 
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We have now finished adding channel data values, so click on the ‘Continue’ 
button to move on to the next stage. 

 

 
 

Click on the first “time” value (72.867) in the grid and click on the ‘Mark 
Column’ button on the dialog box.  Select ‘Add To Matrix...’ and change the 
information to match that shown below, then press ‘OK’. 

 

 
 

We do not need to add any further information to the object, so click on the 
‘Continue’ button and then the ‘Done’ button (this is actually still the continue 
button, but the text changes). 
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At this point, you will be asked whether or not you want to save the import 
macro, and under normal circumstances, you probably would want to.  However, 
as “log4.txt” is one of the demonstration files supplied with the system, it will 
probably be of no further use. 

 

Viewing the resultant matrix 
in the GRAPH module. 
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XLDriver - Microsoft Excel Data Exchange 

Introduction 
The XLDRIVER module allows bi-directional data linking to Microsoft Excel 
using DDE (Dynamic Data Exchange). XLDRIVER uses layouts to specify the 
position of data items in Excel.  Layouts are easy to create using the 
XLDRIVER layout wizard, which takes you through all the steps necessary to 
create a layout; once created the layout can be stored for later use. 

Importing Data 
To import data into nVision, the XLDRIVER needs to know where to look for 
the information in Excel.  To do this we use a layout.  Layouts are created using 
the layout wizard. In this example, we’ll import a 10x10 channel of data from 
Excel along with its row and column labels. 

Execute the XLDRIVER module from the Custom toolbar, and click on the 
‘Import…’ button.  If Excel is not currently running you will be asked if you 
want to start the program now. We are now asked to pick a layout.  If you had 
previously defined layouts, they would appear in the list ready to be used again.  
Select ‘Make new layout’ and press ‘OK’.   

 

 

 

 

You will now be placed in stage 1 of the layout wizard.  From here, you select 
the Excel workbook from which you will import data.  If you select the ‘Use 
shading in Excel’ option then whenever you select an area in Excel to import (or 
export), the area will be highlighted, so you know exactly what you are 
importing.  This is not recommended for large areas. 

 

 

 

Each stage of the layout wizard uses the same five buttons, Help, Cancel, Back, 
Next and Finish.  ‘Back’ and ‘Next’ allow you to look at the previous stage or 
next layout stage respectively.  
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You can ‘Finish’ using the layout wizard after the third stage, using default 
values for the remaining questions.  If you press ‘Finish’ before then you will be 
warned that insufficient information has been entered and given the choice to 
return to the layout wizard. 

 

 

 

 

Stage 2 of the layout wizard lets you select the orientation of your data.  This 
stage need not concern us since we are just starting, so we will just select the 
default setting offered.  More information on this stage can be found in the on-
line help for XLDRIVER. 

Stage 3 of the layout wizard allows you to define channels of data.  You add a 
channel to the layout by highlighting the area in Excel and then pressing the 
‘Add to Layout’ button.  XLDRIVER always uses the currently marked area in 
Excel when adding information about layouts.  The current selection in Excel is 
shown in the ‘Current Range’ box. 

 

 

 

 

Once you have added the first channel subsequent additions can be sized 
automatically by using the ‘Auto size’ or ‘Drill from master’ option.  (See on-
line help for more details.) 

For our example, type some numbers into a 10x10 area in Excel.  Now highlight 
this block in Excel; the current range should be similar to the one shown above.  
Now press ‘Add to Layout’. 
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The channel description box will now appear.  This box lets you give the 
channel a name and select its units.  Accept the default name and type something 
in for the units, then press ‘OK’. 

You will now see the information about the newly entered channel in the list box 
on the right-hand side of the stage 3 layout wizard.  We only wanted one 
channel of data, so we can now move onto the next stage by pressing the 
‘Next>’ button. 

 

 

 

 

In stage 4, we define any row & column data that we need to import.  If you 
click in Excel, you will notice that the current selection is automatically sized.  
This allows you to enter the row & column labels very quickly.  The type of 
label that is to be added depends upon the selection in the ‘Label Type’ group.  
Once you have defined the row/column that you require, the procedure to add it 
is the same as it is for adding a channel. 

The remaining stages of the layout wizard define the text you can associate with 
individual channels & the data set as a whole.  We are not concerned with them 
here so choose the ‘Finish’ button. 

You will then be asked if you want to save the layout; choose ‘No’.  Then you 
will be asked for a name for the matrix that will be created; accept the default 
name by clicking ‘OK’. 
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 A new matrix will have appeared in the Data Window.  If you drop it in the 
editor module, you will see that the values match those that are in Excel.  You 
can test the dynamic linking by changing values in Excel and nVision. 

Exporting Data 
In this example, we’ll export a data set to Excel, and create a hot link, so that 
changes made in nVision are automatically updated in the Excel sheet. 

Execute the XLDRIVER module, and load “octave1” in the first bay. 

 

 

 
Once the data set is loaded, click on the ‘Export’ button to start the export 
operation.  If Excel isn’t currently running, XLDRIVER will ask if you want to 
execute it.  Presumably, we do, and if Excel is on the path, it should run. 

 

 

 

We are now asked to pick the layout we want.  Layouts are created using the 
Layout Wizard.  This is a series of six dialog boxes that guide you through the 
process of creating a layout.  We will select the default layout; this is one created 
by XLDRIVER to fit the matrix we are going to export.   

Select ‘Use default layout’ and press ‘OK’.  The first stage of the layout wizard 
will appear.  Select a book from the list box and press ‘Next>’.  Since this is the 
default layout, all the other stages will have been done already, so press ‘Finish’.  
The layout wizard will only let you press the ‘Finish’ button when it is safe to do 
so. 

You will now be asked if you want to save the layout.  If you had a layout that 
was going to be used again, you would answer ‘Yes’.  Since we have used the 
default layout, there is no need to save it.  The data is now transferred to Excel. 
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Now that the link is established, you can make changes to the “octave1” data in 
an nVision module, and the changes will be reflected in the “Sheet1” sheet in 
Excel. 
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Report Writing Tour 

Overview 
This tour will demonstrate how to integrate the results of analysis and 
measurement in nVision with reports written in Microsoft Word (or similar word 
processor).  

Introduction 
Results, tables and graphs from nVision can be easily incorporated into word 
processor documents enabling reports to be written as the measurement and 
analysis proceeds.  This significantly shortens the time to complete the report, 
and minimises the opportunities for mistakes that can occur when reports are 
written after the event. 

This tour focuses on the use of Microsoft Word; however, any Microsoft 
Windows 95/98/ME/2000/XP word processor would enable these techniques to 
be used. 

Using nVision with other Applications 
 

nVision results can easily be transferred to a word processor such as Word using 
cut and paste techniques.  While you are acquiring or analysing data in nVision, 
you can keep your word processor program open, ready to accept results and 
make conclusions as you work.  However to keep the screen from getting too 
cluttered it’s a good idea to minimise windows that are not in use.  These 
applications can easily be restored from the taskbar. 

 

Using the taskbar to move 
between nVision and other 
applications 
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Incorporating graphs 
Copying graphs to the 
clipboard 

Graphs displayed in the modules from the Base 1 and Base 2 toolbars 
can be copied to the Windows clipboard, and then pasted into other 
Windows applications. 

 

In the nVision window, click on ‘View’, ‘Copy to Clipboard…’ to copy 
the window.  A dialog box will give you some options on how to 
manipulate the image that is copied.  

Once on the clipboard, you can paste the image into your document 
using Word’s ‘Edit’, ‘Paste Special…’ menu options. 
 

 

Copy to clipboard dialog 

 
 

The copy allows a number of image-processing options.  These are 
designed to ensure that the graphs are legible on paper.  Remember that 
colours that look good on the screen may not look good on paper.  For 
example: 

When printed on a black and white printer dark backgrounds may 
obscure the data. 

Light coloured text on dark backgrounds may not show up well on a 
colour printer output. 
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Colour Selecting colour output will reproduce the window just as it is on 
screen, without the borders or menus: 
 

 

Colour, Use white 
background for DIB 

Clicking on ‘Use white background for DIB’ will make the background 
white.  This will normally emphasise the data and text on printed output. 
 

 

Monochrome The monochrome option will convert the clipboard to black and white 
only. 
 

(Tip - remember Paint can swap black and white areas if you prefer.) 
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Tips Remember you can easily manipulate the graphs either in Word or by 
using Paint to:- 

change colours and backgrounds to highlight data, 

add distinctive arrows, boxes, or clipart to accentuate data features, 

delete unwanted text, and 

make your report more readable - and more fun 

Remember that ANY Window can be copied to the clipboard: 

Use the Print Screen key to copy the entire screen to the clipboard. 

Use Alt-Print Screen keys together to copy the current, active 
window. 

Highlighting Points of Interest on Graphs  
 

Highlight points of interest 
in nVision data 

Whatever cursors are currently in the nVision graph displays will be 
copied to the clipboard too.   Note that the copy will copy ANY window 
that overlaps the window border - so if you have a cursor readout 
window onscreen it will be copied provided it is within the borders of 
the copied window. 

 

 

 Of course, the cursor readout box could also be copied separately by 
clicking on it to make it the active window then using the keyboard 
command Alt-Print Screen to copy it to the clipboard. 
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Using Notes Fields 
Using nVision 
notes fields to 
annotate data 
features. 

The nVision Notes command allows text descriptions of data features to 
be stored with the data object itself.  The descriptions can be tied to data 
samples using the cursor, or a range of samples. 

Notes can be displayed in the graph display (select menu option ‘View’, 
‘Display’, ‘Notes’) - and when displayed can be copied to the clipboard 
to include in reports. 

The text boxes can be repositioned and resized by the user, and since the 
labels are stored with the data, they appear whenever the data is 
displayed. 

Using Word to annotate 
data 

Of course, once an nVision display has been copied to the clipboard 
you can use Word, Paint or any Windows application to add text, 
markers and highlight important data features. 

Double clicking on the picture in Word will allow you to edit it.  This 
includes the ability to add lines and arrows, text boxes and “callout”  - 
text boxes joined to features of the picture by lines. 

Callout text -
This is the start
of the door slam,
as the seal meets
the door frame

This is a text box
by the second
impact
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Including statistical analysis  
Including statistical analysis 
results 

The STATISTICS module outputs tables of statistical 
analysis of the data, and includes a write to clipboard option 
in its menu for easy pasting of results into reports. 

 
 

Embedding Sounds 
If the recipients of your report have sound cards in their PCs, then you can 
include sound clips as objects in your report.  Then the readers of your report 
can hear your conclusions for themselves.  Sound playback can be a useful way 
of distinguishing the features of any time signal within the audio frequency 
range, not just sound recordings - for example acceleration data. 

 

Creating a WAVE file using 
nVision EXCHANGE 

Any signal or matrix can be exported into a WAVE format sound file 
using the EXCHANGE program. 

 
   

Embedding a WAVE file 
object into a Word document 

In Word, the sound file can be embedded as an object.  From the Word 
menu, select ‘Insert’, ‘Object’, and select the ‘Create from File’ tab in 
the dialog box.  Entering the filename of the wave file created in 
nVision will embed it in your document, represented by an icon. 

Double clicking on the icon will cause the sound to be replayed. 
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Appendix A 

Hardware Key 

Overview 
The “Hardware Key”, sometimes referred to as a “dongle” is a small device that 
plugs into the computer’s parallel or USB port.  Its purpose is to determine the 
validity of the user’s licence, and to restrict access to the software modules 
according to the user’s particular licence.  

Without a hardware key, nVision will run in demonstration mode where some of 
the system facilities will be disabled or completely unavailable. 

The hardware key also contains customer name information, which appears on 
the system ‘About’ dialog box, and details of the particular software modules 
with which it will work. 

Installation 

 

Precautions 

WHEN CHANGING CONNECTIONS AND CABLING, TURN OFF 
POWER TO THE COMPUTER AND OTHER EXTERNAL DEVICES. 
FAILURE TO OBSERVE THIS SIMPLE PRECAUTION COULD 
RESULT IN PERMANENT DAMAGE TO THE EQUIPMENT 

Connecting the key to a PC 
To connect the hardware key to your PC, you should follow these steps: 

• Switch off the power to the computer and all peripheral devices such as 
printers and plotters. 

• Locate the parallel printer port, LPT1 (a 25 pin D-Type connector).  If in 
doubt, identify this port connection with the help of the hardware manual 
supplied with your computer. 

• Connect the hardware key to this connector.  There are arrows engraved on 
the case of the key that indicate which end goes into the computer. 
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• If you previously had a peripheral connected to LPT1 then connect this to 
the socket on the available end of the hardware key.  (The key is a 
transparent device, so does not affect peripheral operation.) 

Upgrading your Hardware Key 

What is a field upgrade? 
The hardware key can be upgraded to enable you to access other elements of the 
nVision system, without needing to return the key for modification.  To do this 
you need to contact your nVision agent who can supply you with an upgrade 
code, usually by fax. 

When can I use a field upgrade? 
If you simply want to release additional features in an existing installation, then 
all you need is an upgrade code.  If you want to use new features, which have 
been added to the system in a later release of the software, you will first have to 
obtain and install a new set of software.  Your new set of software disks will be 
supplied with a new code for your key. 

How to use an upgrade code 
Once you have received your upgrade code, it is a simple task to go about 
upgrading the key.  To upgrade the key you need to use a program called 
“Keyuser” which will have been installed in your program manager group or 
program folder for nVision. 

 

Keyuser Key Upgrade  Icon 

 

 

To start Keyuser, select its menu entry in the nVision group from the ‘Start’ 
menu ‘Programs’ option. 

 

The Key Upgrade Program 

 
If the hardware key is NOT connected correctly, the Keyuser program will give 
an “Error opening key” message on start-up or pressing ‘Read’. 
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Upgrade procedure step by step 
To upgrade your key, follow these steps: 

• Make sure the hardware key you are going to upgrade is connected to your 
machine. 

• Run the Keyuser program.  Click on the ‘Read’ button to read in the details 
from the key if it hasn’t already done this automatically. 

• If the details in the ‘Customer’ text box are not correct or you want to 
change them then type in either your own or your company’s details 
(maximum 35 characters). 

• If the ‘Site ID’ text box details are not correct or need changing then type in 
the site ID for the key (maximum 2 characters). 

• Finally and most importantly you need to type in the upgrade code into the 
‘Upgrade Code’ text box.  The code is a 56-character string consisting of 
the numbers ‘0’ to ‘9’ and the letters ‘A’ to ‘F’.  On the upgrade code sheet 
it is broken up into 14 blocks of 4 characters separated by dashes for ease of 
reading.  When you enter the code, you must type it in without the dashes. 

 

When you have typed all 56 characters correctly, the ‘Write’ command button 
should become enabled, the ‘Write’ button label changing from light grey to 
black.  When this occurs simply click on the ‘Write’ button to write the new 
details to the hardware key.  If the ‘Write’ button does not become enabled then 
you should check that the code has been typed in correctly and is actually for the 
key number displayed in the ‘Serial’ box.  If none of this enables the ‘Write’ 
button then there is a problem with the upgrade code and you should contact 
your nVision agent for a new code. 
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Appendix B 

Additional Sample Data 

Do I need the additional data? 
This step is optional, since all of the sample data required to follow 
the more basic tutorials is present on the standard distribution 
disks.  However, once the tutorials have been completed, you may 
wish to explore the system in detail, using a more varied set of 
data. 

Installation overview 
There is no installation for the nVision sample data, since the files 
can be loaded as required from the nVision CD.  Windows 
Explorer can be used to copy any or all of the sample data to your 
hard drive from the ‘DEMODATA’ and ‘MOREDATA’ folders. 
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P 

Paint · 122 
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